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2 0 1 8 年 3 月 2 8 日 
電子リソースデータ共有作業部会 

 
電子リソース管理システムの利用可能性の検証について（2017 年度最終報告） 

 
1. 背景 

 電子リソースデータ共有作業部会では，電子リソース業務のワークフロー改善に関

する検討を行っている。2015～2016 年度に実施した ProQuest 社の 360 Resource 
Manager Consortium Edition を使用したワークフロー検証では，各図書館での電子

リソース管理業務の効率化や利用者サービスの向上に関し有効性を確認したが，コン

ソーシアム事務局と会員館のデータ共有に関し，必ずしも JUSTICE 等を通じて行わ

れている日本の契約モデルと適合しない部分があった。一方海外では，大学や地域・

国レベルのコンソーシアムで，「印刷体」と「電子情報資源」の一括管理が可能な図書

館サービスプラットフォーム（LSP）の導入が広がり，既存の図書館システム（ILS）
や電子リソース管理システム（ERMS）からの移行が行われている。 
 そこで本作業部会では，JUSTICE 会員館からの協力員を増員し，LSP の主要製品

である Ex Libris 社の Alma を利用した電子リソース業務のワークフロー検証を行っ

た。以下はその 2017 年度報告である。 
 

2. 検証概要 
(ア) 実施主体： 電子リソースデータ共有作業部会 
(イ) 実施対象： Alma（Ex Libris 社） 
(ウ) 実施期間： 1 年間（2017 年 1 月～12 月） 

 
3. 検証によって期待するワークフロー 

 以下は，現在の電子リソース業務と，LSP の利用によって期待される電子リソース

業務のワークフロー図である。 
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4. 検証結果の要点 
 本検証では，Almaが提供する多岐の機能について，業務手順の確認を行った（→ 「5. 
検証結果の詳細」を参照）。この報告では，そのうち JUSTICE 会員館で行っている

「購読誌のリニューアル」「アクセス管理・サービス提供」「購読誌の分析・評価」の

３業務を取り上げ，特に電子リソース管理システムの非導入館を想定した典型的なワ

ークフローとその課題解決について説明する。 
 

(ア) 購読誌のリニューアル 
JUSTICE 会員館では，以下の手順で購読誌のリニューアルを実施している。 
 
 
 
 
 
 
 
これらについて，以下の課題がある。 
(1) 「②提案書入手・確認」では，会員館において契約条件・提供条件について，

前年との比較を行っているが，JUSTICE 提案書や Agreement は十分な標準

化・データ化が行われていないため，確認に時間を要しており，各会員館で

の重複作業となっている。 
(2) 「③購読誌の入替」では，JUSTICE 提案のパッケージについても，タイト

ルリストの差分調査（移管・前年比較）を会員館それぞれが行う必要がある。 
(3) 毎年の契約情報とアクセス可能なタイトルを体系的に管理することが難しく，

会計的な説明が困難な場合がある。 
 
検証の結果，Alma の利用により，以下の業務改善が見込まれることが明らかと

なった。 
(1) Alma が提供する，冊子体と電子リソースが一体となった購読管理機能によ

って，①~⑧までのすべての業務がサポートされていた。会員館が翌年契約

情報の予算・価格等の情報を前年のデータから一括作成することで，翌年の

契約条件・提供条件と比較しながら「②提案書入手・確認」「③購読誌の入替」

を行うことが可能であった。 
(2) リニューアルのリマインド機能や，契約管理画面から各提供元への見積／発

注依頼等の連絡機能を備えており，版元が EDI（Electronic Data 
Interchange）に対応していれば，システムから自動的に発注を行うことも

可能であった。 
(3) 過去も含めた電子リソースの契約内容がシステム内に記録されていることに
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より，会計的な透明性の向上が見込まれる。 
 
また，JUSTICE 事務局が以下の作業を実施することにより，各会員館で重複し

て行っていた作業の大幅な削減が期待できる。 
(1) 交渉結果の提案書と Agreement サンプルについて，正規化されたデータを

システムに登録し，会員館へ提供する。 
(2) 交渉結果のタイトルリストについて，前年との差分情報（新規 / 更新 / 移

管 / 中止）を抽出し，会員館へ提供する。これにより，非システム利用館に

おいても，購読誌の契約漏れがないか確認が容易になる。 
 

(イ) アクセス管理・サービス提供 
JUSTICE 会員館では，以下の手順で電子リソースのアクセス管理・サービス提

供を実施している。 
 
 
 
 
 
 
 
 
これらについて，以下の課題がある。 
(1) 「⑨タイトルリストの更新」では，出版社から JUSTICE に提出されたタイ

トルリストを利用する場合も多いが，データフォーマットが標準化されてお

らず，会員館での標準化作業が重複している。 
(2) 「⑩アクティベーション」では，購読中止後に残るアーカイバルアクセス権

の管理が体系的に行われていない。そのため，購読中止したタイトルのサー

ビス提供が十分に行われていない場合がある。 
(3) 「⑬ユーザからの問合せ対応／パッケージタイトル変更（随時）」では，

JUSTICE 提案書や Agreement は，会員館の契約担当部署でファイルや紙媒

体によって保管されている場合が多く，エンドユーザやサービス担当者が，

契約した電子リソースの利用条件を適時参照することが困難である。 
 

検証の結果，Alma の利用により，以下の業務改善が見込まれることが明らかと

なった。 
(1) Alma が提供するアクティベーション機能の利用により，⑨~⑬までのすべて

の業務がサポートされていた。購読誌は『契約－ライセンス－パッケージ（タ

イトルリスト）』が相互に紐づいた状態でシステム管理されており，「⑩アク
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ティベーション」で行う翌年パッケージのアクティベートや，前年パッケー

ジのディアクティベートを一括して行い，システム上から直接アクセス確認

を行うことが可能であった。 
(2) 購読中止後のアーカイバルアクセス権については，パッケージに紐づいたラ

イセンス情報を参照することで確認し，ナレッジベースのメンテナンスを行

うことが可能であった。ただし，Alma が提供するグローバル・ナレッジベ

ースの品質については，本検証のなかで十分に確認できなかったため，引き

続き評価を行う必要がある。 
(3) Alma が提供する API 機能により，エンドユーザ向け検索インターフェース

である Primo 上での利用条件表示が実現していた。 
 

また，JUSTICE 事務局が以下の作業を実施することにより，各会員館で重複し

て行っていた作業の大幅な削減が期待できる。 
(1) 交渉結果のタイトルリストについて，正規化されたデータをシステムに登録

し，会員館及び会員館が利用するナレッジベースベンダーに提供する。

JUSTICE 事務局が提供する標準形式のタイトルリストを利用することで，

参加館は OPAC や商用 KB へのデータ取り込みが容易になる。その際，タイ

トルリストがグローバルと共通か JUSTICE 独自かの情報も提供することで，

重複データの作成・管理が省かれる。 
(2) タイトルリストは，契約期間内の入替も行われているため，適宜更新する。 

 
(ウ) 購読誌の分析・評価 

JUSTICE 会員館では，予算等の制約による購読誌見直しの際，以下の手順で購

読誌の分析・評価を実施している。 
 
 
 
 
 
 
 
 
 
これらについて，以下のような課題がある。 
(1) 「⑭利用統計を取得」では，提供元ごとに，毎年人手により利用統計を取得

／蓄積する必要があるため，作業が煩雑である。 
(2) 「⑮購読金額の調査」では，契約金額や予算，冊子体購読の有無も考慮する

場合があり，図書館システムや提供元との契約時に作成した Excel 表等から
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情報を収集する必要がある。 
(3) 「⑯費用対効果の算出」「⑰評価・シミュレーション資料作成」では，提供元

をまたいで横断的に分析を行うために，⑭で取得した利用統計や⑮で収集し

た金額情報を標準化して比較するする必要があり，膨大なデータ加工作業が

発生している。 
 

検証の結果，Alma の利用により，以下の業務改善が見込まれることが明らかと

なった。 
(1) SUSHI および COUNTER 対応の統計システムを有しており，提供元が提供

するアクセス統計の月次での自動取得や，COUNTER 形式のアクセス統計

のアップロードを行うことができた。 
(2) Alma の統計・分析モジュールは，Oracle Business Intelligence（OBI）を

採用しており，この強力かつ柔軟なレポート機能により，費用対効果の経年

比較のほか，より高度な統計分析も可能となっていた。 
 

5. 検証結果の詳細 
 上記以外の検証結果については，以下の別紙にまとめた。 
(ア) 別紙「Alma 機能検証結果（個別機能）」 

 
6. 次のアクション 

 2018 年度は，上記の検証結果をもとに，実運用時におけるさらなる課題の洗い出し

を進めるため，JUSTICE 事務局および複数の JUSTICE 会員館と協同で，実際の業

務で発生するものと同一の情報を LSP に登録し，試行的な業務運用を行いたい。 
 

以上 
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Alma 機能検証結果（個別機能） 

 

◎検証結果の記載要領 

本検証結果（個別機能）は以下の要領で記載した。 

 

(1) 主な検証内容 

(2) 検証時に利用した Alma のメニュー項目 

例：Acquisitions > Purchase Order Lines > Search for PO Line 

(3) 検証結果 

(4) 機能評価 

※S、A、B、C、D、評価なし 

S：機能は業務実施に必要な水準をはるかに上回り、きわめて優れている。 

A：機能は業務実施に必要な水準を上回り、優れている。 

B：機能は業務実施に必要な水準に達しており、普通である。 

C：機能は業務実施に必要な水準を下回り、やや劣っている。 

D：機能は業務実施に必要な水準をはるかに下回り、致命的な問題を抱えている。 

評価なし：求める機能が全く存在しない。 

評価なし（検証環境の制約による）：検証環境の制約により、マニュアルベースでのみ

検証を実施した。 

なお「業務実施に必要な水準」とは検証時点において国内各機関で利用されている図書

館システムで実現されている機能水準を指す。 

(5) 改善への提言（必要な場合のみ記載） 

導入に際し，より理想的な機能になるための具体的な提言を記載。 

(6) 導入時の留意点（必要な場合のみ記載） 

導入に際し，日本側または機関側で留意が必要な事項を記載。 

 

「電子リソース業務」内の各項目に振られた見出し番号 1～17 は、本紙「電子リソース管

理システムの利用可能性の検証について（2017 年度報告）」の業務手順番号①～⑰と対応

している。Alma 特有の用語・略語については、末尾に「用語集」を用意した。 
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◎検証環境 

・Network という名称を与えられた Network Zone：ネットワークゾーン（コンソーシア

ム）版×１ 

・Tokyo, Osaka という名称を与えられた単館向け機関ゾーン×２ 

Tokyo Osaka はいずれも同一の Network（コンソーシアム）に参加している設定となって

いることから、ネットワーク版によって管理される Tokyo, Osaka の共有領域（Network 

Zone）にアクセスすることが可能 

 

 

 

 

 

 

 

 

 

 

図：Alma による目録／アクセスデータのフロー 

（出典：上野友稔，香川朋子，片岡真. 共同運用による図書館システム導入の新たな可能性. 

カレントアウェアネス. 2017, (331), CA1896, p. 22-28.） 

 

◎定例会 

・検証期間内に Alma の開発・提供ベンダーである Ex Libris 社と作業部会の間で 15 回の

定例会をテレビ会議で実施した。 

・定例のほか、Ex Libris 社と対面して意見交換が行える参加型ワークショップを 2 日間に

わたり実施した。 

 

◎検証実施主体 

・これからの学術情報システム構築検討委員会 電子リソースデータ共有作業部会 

電気通信大学、鹿児島大学、神戸大学、北海道大学、佛教大学、国立研究開発法人国際農林

水産業研究センター、国立情報学研究所【JUSTICE 事務局】からの委員と、東京工業大学、

早稲田大学、国立極地研究所からの協力員によって構成 
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≪電子リソース業務≫ 
(ア) 購読誌のリニューアル 
 

概要 

 

 発注・受入・支払いについて、図書や雑誌、冊子や電子、有料・無料など資料の形態や購

読形態に合わせて設定でき、データの作成方法についても手動・データ取り込み・API の利

用による作成が用意されている。Network Zone（以下，NZ）のライセンスのデータを流用

して Institution Zone（以下，IZ）で発注・支払いをする、あるいは NZ のライセンスを IZ

の複数機関で分担購入するといったことも可能である。 

 ライセンスは手動・ONIX-PL 形式で作成することができ、現在検討している提供条件の

必須項目がデフォルトで存在していること、また、不足している項目が容易に追加できるこ

とも確認した。ただし、Alma の初期設定は必要な項目が表示されていないこともあり、利

用の前に調整が必要である。 

 NZ で作成したライセンス情報は、IZ へ配布・再配布ができ、IZ では配布されたライセ

ンス情報をそのまま利用する、あるいはコピーを修正して利用することができる。課題とし

ては、NZ から IZ への配布時に、ライセンスだけでなく、ライセンスに紐付けたタイトル

リスト・添付ファイルも含めることが望ましいこと、また、IZ でライセンスに対して紐付

けた Inventory がネットワークで参照できる機能の実現がある。 

 発注用データと連携したトライアル管理用のデータ作成も可能であり、契約時には連携

した発注データを使用して発注・支払いができる。 

 

総合評価 

 

B
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1 翌年購読誌の調査 

システムを利用した作業ではないため割愛する。ただし、調査のための基礎資料となる

当年購読誌の一覧等は「（ウ）購読誌の分析・評価」に示したとおり、Analysis から出

力可能である。
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2 提案書入手・確認 

ライセンス情報の管理 

(1) 主な検証内容 

1) 主要なライセンス項目の有無と追加可否 

2) Walk in User など主要なライセンス項目のデフォルト設定の確認 

3) Agreement（文書）の電子化保存の可否 

4) ライセンス項目の Collection（＝パッケージ）・Portfolio（＝個別タイトル）への

紐付け可否 

5) NZ でのライセンス作成に必要な権限の確認 

6) ライセンステンプレートの編集主体の確認 

7) NZ でのライセンス作成 

8) NZ から IZ への継承情報の確認 

9) コンソーシアム参加機関の所蔵表示の確認 

10) IZ でのライセンス変更の可否及びその方法の確認 

11) NZ のライセンス情報の共有フローの確認 

(2) 検証時に利用した Alma のメニュー項目 

1) （NZ/IZ） 

Acquisitions/Acquisition Configuration/Configuration Menu > 

Licenses/Manage Licenses Terms 

2) （IZ）Edit Collections > General Information > License 

3) （IZ）Search > Portfolio List > Edit Portfolio > Acquisition Information > 

License 

4) （NZ）Acquisitions > Acquisition Configuration > Configuration Menu > 

Licenses > License Details > Administrators 

5) （NZ）Acquisitions > Licenses > Add License 

6) アカウントの権限に関する項目 

Configuration > Acquisitions > General > Other Settings, 

「 acq_distribution_job 」 を  「 true 」 へ 変 更 。（ Optionally set 

acq_distribute_changes_last_run to a specific date; see above for a 

description of this parameter.） 

7) ライセンスの共有に関する項目 

a) （NZ）Acquisitions > Licenses > Add License 
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b) （NZ）Acquisitions > Licenses > Summary > Shared License 

c) （NZ）Acquisitions > Licenses > Distribute to member 

(3) 検証結果 

1) 主要なライセンス項目の有無と追加可否 

ライセンスの作成は「手動で行う」「ONIX-PL ファイルをアップロードする」の二

通りの方法が存在する。License 画面で表示するには License Sections の値を選

択する必要がある。デフォルト項目数は 82 個で Add License Terms で項目の追

加も可能である。 

2) Walk in User など主要なライセンス項目のデフォルト設定の確認 

a) Walk in Use の可否 

デフォルト項目にはなく、「Note」のみ存在している。検証では、「83：Walk 

in User」と「84：Simultaneous Access」を追加した。 

b) 同時アクセス数の管理可否 

「19：Course Pack Electronic」と「73：Remote Access」が準備されてい

る。 

c) 授業利用の可否 

「19：Course Pack Electronic」が準備されている。 

d) リモートアクセスの可否 

「73：Remote Access」が準備されている。 

3) Agreement（文書）の電子化保存の可否 

XML・PDF・Word・Excel・Txt の各ファイルがアップロード可能である。 

4) ライセンス項目の Collection（＝パッケージ）・Portfolio（＝個別タイトル）への

紐付け可否 

Collection にライセンスを紐付けすると、含まれる各個別タイトルにも反映され

る。 

5) NZ でのライセンス作成に必要な権限の確認 

a) 管理権限の主体 

NZ のユーザーかつ License Manager ロール（Acquisitions）を有するもの。 

b) 権限の管理方法 

各ライセンスに対して License Details > Administrators で追加・削除がで

きる。 

c) 表示制御機能（表示/非表示の選択） 
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6) ライセンステンプレートの編集主体の確認 

a) コンソーシアム事務局 

NZ で作成したテンプレートに対する編集ができる。 

b) 参加機関 

NZ にユーザーがある参加機関のみ編集ができる。NZ から配布されたライセ

ンスは、IZ でもそのままでは編集できない（後述「Create Amendments」

を参照。） 

7) NZ でのライセンス作成 

a) コンソーシアム事務局（管理者アカウント）が Negotiation License（契約条

件）を NZ に登録する。 

b) Negotiation License が紐付いた Electronic collection（＝パッケージ）を NZ

に作成する。一つの提案書に複数の条件が含まれている場合、全てのパターン

について作成する(例えば、プラン A:100 タイトル、プラン B：100 タイトル

＋理工系 80 タイトルの場合、Negotiation License を、○○ 2017Plan A と、

○○ 2017Plan B に分ける)。 

c) 各機関は IZ に当該 Electronic collection をダウンロードする。 

d) 翌年も継続する場合は、当年分は deactive にし、次年分を active にする。 

e) 購読終了したコレクションは次年のものをダウンロードせず、恒久アクセス

権の残るものは「12-(3)-2)-a)恒久アクセス権の設定」の処理を行う。 

8) NZ から IZ への継承情報の確認 

ライセンス項目が継承できる。 

9) NZ でのコンソーシアム参加機関（IZ）の所蔵表示の確認 

a) 機能が確認できなかった。 

b) NZ での所蔵・契約データの付与 

License > Inventory で Collection 及び Portfolio、License > PO Lines で

契約データを付与できる。 

10) IZ でのライセンス変更の可否及びその方法の確認 

Acquisitions > Licenses > Create Amendments でコピーを作成して編集がで

きる。NZ から配布された情報を IZ で編集したかどうかの記録及び NZ 情報へデ

ータを戻すことも可能である。 

11) NZ のライセンス情報の共有フローの確認 

a) 必要な権限 
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Job Category：Cataloging Manager、Role：Acquisition & Inventory、

「Configuration」のなかで「acq_distribution_job」を 「true」に設定する。 

b) ライセンスの追加 

Acquisitions > Licenses > Add License…IZ と同じ手順で 作成し 、

Summary > Shared License にチェックを入れる。 

c) ライセンスの共有 

Acquisitions > Licenses > Distribute to member で配布するする IZ をチ

ェックして Submit する。 

d) NZ から IZ に配布される情報 

License Terms のみ、Inventory・Attachment は配布されない。 

e) NZ でのライセンスの編集と再配布 

NZ で修正したライセンスを IZ に再配布する機能は有しているが、バグのた

め、本検証では確認できなかった。 

f) コンソーシアム参加機関における分担購入への対応 

NZ で「License Type」が「Negotiation」の場合、IZ に対応した「Negotiation 

Details」に契約情報などを登録できる。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) 柔軟性を担保するために、ライセンス項目の変更権限は現在より多くのユーザー

に開かれるべきである。 

2) NZ のライセンスに対して、各 IZ で登録された（License・Amendment 双方に対

する）Inventory が参照できるとよい。 
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3 購読誌の入替 

(1) 主な検証内容 

1) 継続時の手順 

2) キャンセル時の手順 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Purchase Order Lines > Search for PO Line 

2) Acquisitions > Purchase Order Lines > Renew 

3) Acquisitions > Acquisitions Configuration > Configuration Menu 

4) Resource Management > Manage Inventory > Manage Electronic Resource 

Activation 

(3) 検証結果 

1) 継続時の手順 

a) 手動更新と自動更新の選択 

購入データの Renewal > Manual renewal のチェック欄から設定する。 

b) 手動更新の場合 

データ作成時に Renewal date に設定した日付になると、購入データが

Renew リストに追加される。この時、データ作成時にリマインド開始期間を

設定しておくと、更新日になる前に、あらかじめ Renew リストに追加するこ

ともできる。その後、購読期間や更新日等、必要に応じて購入情報を修正し、

購入データ編集画面の一番下にあるタブを Renew に変更後、実行すると更新

される。 

c) 自動更新の場合 

事前に設定した更新サイクル (1 年など) を元に、更新日が来ると自動的に新

たな更新日に変更される。 

d) 納入者への通知 

自動更新、手動更新共に、Configuration Menu から継続更新完了時に納入者

へ自動的に通知を送信するように設定することができる。 

e) 納入者の変更 

各購入データの編集画面から、一番下にあるタブを Change vendor に変更し

て実行すると、新しい納入者を選択できる。納入者選択後、新しい購入データ

が作成され、それまで使用していた購入データは Closed の状態になる。 

2) キャンセル時の手順 
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キャンセルしたいタイトルの購入データにある Cancel を選択、もしくは編集画面

の一番下にあるタブを Cancel line に変更することで、継続キャンセルができる。

この時キャンセル理由と注記を入力する画面が表示される。同時に、納入者へのキ

ャンセル通知の送信設定も行うことが出来、設定しておくとキャンセル完了時に

納入者へキャンセル通知が送信される。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) 自動更新の場合、ホーム画面の Task に表示されないため、手動更新よりも更新時

期を見落とす可能性が高くなってしまうのではないかと考えられる。自動・手動問

わず、更新時期の通知をよりわかりやすくした方が誤発注などのミスも防ぐこと

ができるのではないか (例：Alma ログイン時に継続更新時期にさしかかったタイ

トルがあることを表示する)。 
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4 予算調整 

(1) 主な検証内容 

1) 図書館や部局との価格の按分の可否 

2) 外部財務システムとの連携のための予算コード設定の可否 

3) 外部財務システムとの連携可否 

4) 日本における電子ジャーナル購読時の必要項目の有無 

(2) 検証時に利用した Alma のメニュー項目 

1) 各 Purchase Order Line（＝発注単位。以下，POL） 

按分比の一括付与： 

Admin > Manage Job and Sets > Run a Job > Update PO Lines transactions 

2) 外部財務システムとの連携のための予算コード設定の可否 

Acquisitions > Acquisitions Infrastructure > Funds and Ledgers 

3) 外部財務システムとの連携可否 

Alma Configuration > General > External Systems > Integration Profiles 

4) 日本における電子ジャーナル購読時の必要項目の有無 

Acquisitions > Acquisitions Infrastructure > Licenses 

(3) 検証結果 

1) 図書館や部局との価格の按分の可否 

a) 複数予算の登録 

各 POL を作成する際に複数の予算（Fund）が登録可能である。 

b) 按分比での設定可否 

登録時に各予算の比率が設定可能である。設定後に総額が変更した場合も、比

率に従い按分価格が修正される。 

c) 按分比の一括付与 

指定の POL の価格按分を設定する job を作ることができる。検索条件と処理

を作成 > Run a job > 同 PO 内の POL を指定することで、当該 PO 内の POL

全てにおいて同じパーセンテージによる按分が可能。 

d) 部局・研究室等による分担 

予算に部局・研究室等を付与することで、例えば図書館：部局＝3：1 等の分

担を表現することも可能である。 

2) 外部財務システムとの連携のための予算コード設定の可否 

External ID（他システムとの連携用 ID）があり、Owned by 項目でキャンパス、
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部局、研究室といった予算管理者を設定可能である。 

3) 外部財務システムとの連携可否 

a) 連携方法・プロトコル 

b) 財務システムの設定 

System (for Ex Libris' informational purposes)という、財務システムを選

択する項目がある。設定上必須項目なので、日本で使用している財務システム

の追加が必要である。 

c) 連携可能データ 

財務システム→Alma の支払記録のインポート(XML) 

Alma→財務システムへの invoice のエクスポート(XML) 

財務システムと Alma の Fund の同期(CSV or XML) 

PO 及び POL のエクスポート 

d) 連携設定 

自動実行する場合は、毎週水曜日か、毎日(3：00，13:00，18:00，22:00 の

いずれか)から選択可能。手動運用も可能。( Integration Profiles の、

Actions(…) > Edit.) 

e) 図書館別 invoice の出力 

設定項目”Export Invoices For Payment“の、Split By Owner にチェックし

ておくと、図書館別等で invoice を出力できるようになる。 

4) 日本における電子ジャーナル購読時の必要項目の有無 

a) 対象金額の管理 

リバースチャージを記載、計算する項目は POL 及び License にはない。 

Price の項目は原価しかないため、レートや円貨、手数料などを入力する項目

もない。それら全て note に記載する必要がある(各通貨のレート、手数料、算

出根拠、リバースチャージの計算) 

(4) 機能評価 

評価：C（ただし 4）については「評価なし」） 

(5) 改善への提言 

1) POL 単位での按分ではなく、PO 単位での按分もあるとパッケージ単位での按分が

しやすくなる。 

2) 各入力項目の追加のほか、円貨の追加等レート管理もできるとよい。 
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5 Agreement 締結 

システムを利用した作業ではないため割愛する。ただし、Agreement の保管自体は「2-

(3)-3」 Agreement（文書）の電子化保存の可否」に示したとおり可能である。 
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6 契約データ作成 / 7 発注 / 8 支払 

(1) 主な検証内容 

1) 契約データ作成・発注手順 

2) 支払手順 

3) NZ から IZ へのデータ取り込みによる発注の可否 

4) コンソーシアム参加機関における分担購入の対応 

5) NZ の Negotiation（＝コンソーシアム契約）を使用して発注する場合 

6) IZ への反映 

7) 「電子＋冊子」の組み合わせにおける契約情報の管理 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Purchase Order > Approve 

2) Acquisitions > Receiving and Invoicing 

3) Acquisitions > Acquisitions Infrastructure > Licenses 

4) Resource Management > Manage Inventory 

5) Resource Management > Manage Inventory > Manage Electronic Resource 

Activation 

(3) 検証結果 

1) 契約データ作成・発注手順 

a) 書誌データを検索し、該当書誌の[Order]から POL を作成する。この時点で

[Order Now]を選択すれば(b)、(c)を飛ばして発注することも可能。 

b) POL データは手動、あるいは事前の設定により自動でパッケージ化され、

Purchase Order > Approve に表示される。 

c) Purchase Order > Approve に表示された PO について、承認(approve)す

ると発注のメールが Vender と User に送られ、発注処理が完了となる。 

d) この時の Order List はトップページから POL を検索し、該当する PO の

[Attachments]のタブから確認することもできる。 

2) 支払手順 

a) 発注が完了すると、Receiving and Invoicing > Create Invoice から Invoice

を作成できる。Invoice は手動のほか、PO から作成、あるいはデータ取り込

み(EDI、Excel ファイル)によっても作成可能。 

b) 作成した Invoice は Receiving and Invoicing > Search for Invoice から PO

番号などで検索することで確認でき、In Review の段階であれば修正も可能。 
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c) Invoice に問題がなければ支払準備完了(Ready to Paid)となり、この Invoice

を承認することで、支払待ちの状態(Waiting for Payment)となる。 

d) Receiving and Invoicing > Waiting For Payment Invoices から支払い待

ちのインボイスを選択。Summary タブの Payment identifier を入力し、

Payment status を Paid へ切替えて、[Save and Continue]をクリックする

と支払いが完了となる。 

e) (c),(d)は事前設定によりスキップできる。 

3) NZ の書誌を利用して発注する場合 

a) トップ画面で書誌を検索し、「Network」タブに切り替える 

b) 該当する書誌の[order]から発注する 

c) 以下の流れは「1)発注手順」と同じ 

4) 「Negotiation」の License type を使用した場合 

a) License type を「Negotiation」とすることで、1 つのライセンスの費用を複

数の IZ で分担することができる。参加機関・分担金額は[Negotiation Details]

タブに設定できるが、実際の支払い手続きは個々が行うことになっており、そ

の際に List price や Acquisition method や固定されておらず、支払い時に留

意が必要である。なお、本機能は価格も含めたコンソーシアム契約の場合に利

用される機能である。 

b) NZ で Acquisitions Infrastructure > Licenses → [Add License]より、対象

のライセンスを作成する。License type には「Negotiation」を設定する。 

c) 作成したライセンスの編集画面で以下の項目を設定する。 

[License Terms]タブで、利用条件・禁止事項などの設定 

[Inventory]タブで、該当するパッケージ(Electronic Collection)の設定 

[Negotiation Details]タブでライセンスに参加する(Institution)やその負担

額の設定 

d) パッケージやジャーナルがアクティブになっていない場合は Manage 

Inventory > Manage Electronic Resource Activation より、パッケージの

ステータスを切り替える。 

e) IZ のトップ画面から Electronic Collection で検索し、[Network]タブに切り

替えると NZ の情報が出てくる。該当する Portfolio を選択し、右上 or 右下の

[コピー]を押す。 

f) IZ コピーされた Portfolio の[Order]から発注する。支払いに関しては通常の
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支払手順と同じ。 

g) IZ にコピーする際に[Link]ボタンを押すと、NZ のデータに対してリンクだけ

を貼ることができる。 

5) IZ への反映 

NZ の情報を流用して IZ で発注・支払いができるが、流用だけでは IZ には反映さ

れないので、IZ で検索したい場合は NZ 内の Portfolio のデータをコピーまたはリ

ンクさせる必要がある。 

6) 「電子＋冊子」の組み合わせにおける契約情報の管理 

a) 「冊子+電子」のパターン 

b) 「冊子+無償の電子」のパターン 

c) 「冊子（DDP：Deeply Discounted Print）+電子」のパターン 

 Resource Management > Repository Search から購入するタイトルを

選び Order する。冊子と電子それぞれの POL を作成する。 

 手動でのパッケージ化（詳細は⑥契約データ作成を参照）を選択すると、

Acquisitions > Purchase Order > Package にパッケージ化されていな

い POL が残っている。まとめたい POL にチェックを入れ、Create New 

PO を選択すると、冊子＋電子の PO が作成できる。PO > PO line list に

該当の POL がない場合は、Add PO Line で追加可能である。 

 それぞれの POL で指定した価格の合計が Order Charges に記載される。

冊子と電子の POL が分かれており、それぞれ価格をつけることができる

ため、DDP も表現可能である。 

 無償の電子版の場合は EJ の POL、冊子が付録の場合は冊子の POL の

Acquisition method を Technical に指定すれば価格の入力が不要となり、

無料であることを表現できる。 

 冊子＋電子のタイトルを含んだ複数タイトルの発注を特定のベンダーに

一度にする際は、冊子＋電子の 1 契約を 1PO として管理できないため、

契約形態に関する記述をメモ等に残す必要がある。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) メニューに表示する項目を減らし、類似する機能が同じページにまとめられてい

るとより使いやすい。 
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2) メイン画面から PO や Invoice を検索する時に、複数条件が指定できるとよい。 

3) 検索直後の画面でエクセル以外に csv や txt などで出力できるとよい。 
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(イ) アクセス管理・サービス提供 
 

概要 

 

利用できる電子リソースの設定について、Alma で設定した購読情報をそのまま利用でき

るため、従来の SFX のように個別に KnowledgeBase から電子リソースを参照して購読期

間などを設定する必要はない。個別にアクティベートする必要のあるタイトルは、Task List

によりアクティベーションの進捗状況を管理することもできる。このため、購読情報の変更

など、設定にかかる労力の大幅な削減が期待できる。利用者から見ても、常に正確な情報を

参照できる可能性が高まり、利便性は向上すると考えられる。 

リゾルバ機能は、文献データベースなど外部のリソースから自館で利用可能な電子リソ

ースへ利用者を誘導することが主たる機能である。本検証環境においては、従来のリンクソ

ース→中間窓→リンクターゲットという画面遷移に依らず、Primo と利用者インターフェ

ースが統合されている。例えば、リンクターゲットが自館から利用可能な電子または冊子体

のリソースあるいは文献複写依頼など自館のサービスであった場合、中間窓として Primo

の検索結果と同様の内容を利用者に提示することができる。A-Z リスト、CitationLinker に

ついても同様に Primo に統合されたインターフェースで利用できる。 

これにより、利用者からは、外部のリソースから Primo を経由して必要なリソースを利

用するように見え、従来の SFX などリンクリゾルバ単体での中間窓を経由したナビゲーシ

ョンと比較して画面デザインが変わる、中間窓がポップアップされるなどの大幅な画面遷

移がなく利便性は高いと考える。また、詳細なライセンス情報も表示でき、利用者だけでな

く ILL 等の担当者からみても利便性は高い。 

Primo/Summon から Alma のデータを参照するには、Alma から Primo/Summon に

Publish という方法でデータを反映させる必要がある。NZ からの Primo/Summon データ

反映は、Alma IZ→NZ→Primo/Summon の順に Publish することで実現できる。ただし

Primo VE という新しいバージョンでは Alma のレコードを直接検索可能になるため、

Publish は不要となる。 

 

総合評価 

 

B
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9 タイトルリスト更新 

(1) 主な検証内容 

1) 購読年度ごとの契約条件や利用可能範囲の管理可否 

2) 購読中止後の恒久アクセス権の設定可否 

3) 認証に関わる設定項目の管理可否 

(2) 検証時に利用した Alma のメニュー項目 

1) Collection > Edit 

2) Acquisitions > Acquisitions Infrastructure > Vendors 

(3) 検証結果 

1) 購読年度ごとの契約条件や利用可能範囲の管理可否 

a) 購読年度の管理 

 General Information > Acquisitions and License Information 部分で、

Activation date を記述できる。 

 Additional Information > Service > 各ポートフォリオ > Activation 

Information で、"Active from / until date"が記述できる。 

 契約更新等によって Active until date を変更した等の際には、更新記録

が History に蓄積される。 

 Additional Information > Service > Portfolio list > Coverage 

Information > Global/Local Date Information で、ジャーナル毎の

Global 及び Local の利用可能年を確認、設定できる。 

 契約年度ごとにライセンス情報を持つことができないため、Note を使っ

て年ごとに記述するか、Collection 名＋年次の Collection を作り、管理

する必要がある。 

 コンソーシアム契約の場合は、各 Collection に対応するライセンス及び

タイトルリストが変化するため、コンソーシアムの管理者が、年毎の

Collection を作成する必要が生じる。これによって対象 Collection が毎

年変わるため、発注の際に注意が必要となる。各契約機関は毎年、前年の

Collection の deactivate 及び、当年の Collection の activate が必要と

なる。しかし、Collection から抜けたジャーナルで、アーカイバルアクセ

ス権のあるものは、ジャーナル毎に利用可能範囲を Local で修正するな

どし、アクティブのまま管理し続ける必要が生じる。 

b) エンバーゴの設定 
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 Additional Information > Service > Portfolio list > Coverage 

Information に 、 Global Embargo/Rolling Year 、 Local 

Embargo/Rolling Year の項目があり、エンバーゴの確認及び設定が可能

である。Local は個々の契約で別途 Embargo が指定されている際に使用

する。 

2) 購読中止後の恒久アクセス権の設定可否 

a) 恒久アクセス権の設定 

 General information > Access Type に Current / Perpetual の選択が

ある。 

 Electronic Collection Description > Internal description に、“○○年

購読中止。○年～△年アーカイバルアクセス権あり。メンテナンスフィー

○USD”等と記述できる。Note に記述することも可能である。 

 Additional Information > Service > Portfolio list > Activation 

Information の、”Activate new portfolios associated with service 

automatically?”を No にすることでオートアクティブを禁止することが

できる。 

 Active until date を伸ばす(あるいは設定しない/Reset date)ことで恒久

アクセス(アーカイバルアクセス)を表現することができる。 

3) 認証に関わる設定項目の管理可否 

a) 接続元 IP アドレスの管理 

 接続元の IP アドレスの範囲等の管理は、各出版社の Admin ページで管

理する必要がある。 

 キャンパス毎にアクセスできるタイトルが違う、専攻単位の契約等の情

報を管理したい場合は、Acquisitions > Acquisitions Infrastructure > 

Vendors > 各ベンダーの Action > Summary > Interfaces > 

Action > Access Information > Interface General Details に IP 

Address Note あり。 

b) 利用者用 ID、パスワードの管理（リモートアクセス用含む） 

 Acquisitions > Acquisitions Infrastructure > Vendors > 各ベンダ

ーの Action > Summary > Interfaces > Action > Access Information 

> Interface General Details に User ID とパスワードを記載する項目が

ある。 
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 機関購読でない(個人購読者として購入している)場合に使用する。学会の

EJ 等が想定される。 

 アクセス方法が、IP アドレスか、パスワード方式か、なども選択式で記

録可能。あるいは、Collection > Edit > Additional Information > 

Service > 各ポートフォリオ >Service> Linking Information に、

Linking Parameters の項目があるので、そこに追加する方法もあるが、

サービスによって付与できるものは異なる。(シボレス、User ID など) 

c) 学認対応 

 IZ の Alma/Primo の認証を Shibboleth/学認で統合する場合、学認用 ID

と Alma/Primo の ID を統一できるため、特別な対応は不要である。 

 Alma/Primo と学認が別の認証システムを使用する場合は、学認用 ID を

利用者が参照できるようにする必要があるが、利用者管理画面で設定で

きる。 

 Shibboleth 利用は可能(利用者管理画面にて設定)だが、Alma は IdP と

しては利用できないため、各機関が IdP サーバーを立てる必要がある。 

d) 各サービスの管理者 ID とパスワードの管理可否 

 Acquisitions > Acquisitions Infrastructure > Vendors > 各ベンダ

ーの Action > Summary > Interfaces > Action > Administrative 

Information 部分に User ID とパスワードが記載できる。 

 ベンダー毎の管理のため、同一ベンダー・別代理店の場合は注意が必要と

なる。POL に表示されるベンダーは注文先＝代理店になっている可能性

がある。コンソーシアム契約のパッケージで、NZ の Negotiation を使用

している場合は、Licensor（＝ベンダー）と Licensing agent（＝代理店）

の項目が分かれているため、設定しておくことで判別可能になる。 

(4) 機能評価 

評価：B 
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10 アクティベーション / 11 アクセス確認 

(1) 主な検証内容 

1) 個別のタイトルに対するアクティベーション/アクセス確認手順 

2) データベース (パッケージ) に対するアクティベーション/アクセス確認手順 

(2) 検証時に利用した Alma のメニュー項目 

1) Resource Management > Manage Inventory > Manage Electronic Resource 

Activation 

(3) 検証結果 

1) 個別のタイトルに対するアクティベーション/アクセス確認手順 

a) Activation と Deactivation を簡単に切替でき、Alma では即時反映される。

Electronic Resource Activation Task List というものが用意されており、ア

クセス確認は、Electronic Resource Activation Task List 画面の Actions > 

Test Access によって行う。このとき、Deactivation (Not available) の状態

でも Test Access からアクセス確認を行うことができる。 

b) 各タイトルのアクセス確認進行状況を表す項目も Task List に用意されてお

り、Access confirmed・Check access・Not yet Online・Done の 4 種類が

用意されている。リストに追加した直後は Check access の状態になってい

る。Done を選択すると、Task List から除外される。この Task List により、

自分の作業の進行状況を容易に確認できる。 

c) 自分の進行状況だけではなく、他の人に割り当てられたタイトルの作業の進

行状況も確認できる。そのため、全体的なアクセス確認作業がどこまで進んで

いるのか把握できる。 

2) データベース (パッケージ) に対するアクティベーション/アクセス確認手順 

a) Electronic Resource Activation Task List で Action > Test Access を選択

すると、データベースに収録されている各タイトルの一覧が表示され、それぞ

れ Test access からアクセス確認を行う。一つ一つ Activate もしくは

Deactivate に切り替えることも可能だが、複数タイトルをまとめて選択し、

Activate または Deactivate に切り替えることができる。 

b) Edit > Attachment を利用して、各出版社から提供されているタイトルリス

トを添付すれば確認が容易になる可能性がある(添付ファイルのダウンロード

は、Manage Electronic Resource Activation>actions>View から可能)。 

(4) 機能評価 
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評価：B 
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12 エンドユーザー向けサービスへの反映 

A-Z リスト 

(1) 主な検証内容 

1) 利用可能な電子リソースの検索 

2) 表示内容の検証（ライセンス情報など） 

(2) 検証時に利用した Alma のメニュー項目 

1) Primo Back Office , Ongoing Configuration Wizards > Views Wizard 

2) Configuration Menu > Fulfillment > Discovery Interface Display Logic 

(3) 検証結果 

1) Primo 上では「Journal Search」として利用できる。 

2) 利用の設定は Primo Back Office から、Ongoing Configuration Wizards > 

Views Wizard から Tiles Configuration で Main Manu を編集することで a-z リ

ストをメニューに加える。 

3) 検索対象は電子リソースに限る。 

4) SFX の A-Z リストと異なり、Primo の検索結果詳細表示と共通の設定である。 

5) ライセンス情報の表示についても、Primo の検索結果詳細表示と共通である。詳細

はリゾルバ機能での記述を参照されたい。 

(4) 機能評価 

評価：B 

 

リゾルバ機能 

(1) 主な検証内容 

1) 設定方法 

2) 表示内容の検証（ライセンス情報など） 

3) 中間窓での表示位置 

(2) 検証時に利用した Alma のメニュー項目 

1) Configuration Menu > Fulfillment > Discovery Interface Display Logic 

(3) 検証結果 

1) 結果の確認は主にメニューのうち FETCH ITEM（SFX の Citation Linker 相当。

OpenURL の各項をフォームから入力する）を使用して行った。 

2) OpenURL によるクエリの送信を確認した。 

3) 中間窓の表示内容（Send to、Get It など）は Primo の通常の検索結果詳細表示
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と共通の設定である。厳密には、SFX のような中間窓ではなく、OpenURL による

検索結果が Primo で表示される。 

4) 検索結果からリンクしたい外部のサービスがある場合、Configuration Menu > 

Fulfillment > Discovery Interface Display Logic > General Electornic 

Services から設定する。相手先サービスの URL に渡すパラメータは、OpenURL

の項目名に準じている。マニュアルには、ILLiad、Amazon、ProQuest が設定例

として示されている。 

5) ライセンス情報は、Alma の Configuration Menu > Fulfillment > Discovery 

Interface Display Logic > Other Setting で  Enable Display of License 

Information をチェックすると表示が有効になる。以下に表示例を示す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(4) 機能評価 

評価：A 

(5) 改善への提言 

1) リゾルバ機能そのものに関係するものではないが、Primo で表示される Permalink

について同じ情報源を指す場合でも以下のように差異がある。LOD など他の情報

資源からのリンクを考慮すると、共通化すべきではないか。また、Permalink 内に

クエリパラメータはない方が望ましいと考える。 

a) LibrarySearch から：docid を元にした URL 
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b) FETCH ITEM から：OpenURL に準拠した URL 

 

Primo/Summon への反映 

(1) 主な検証内容 

1) Alma の IZ で登録した書誌及び所蔵データの Primo：IZ/Summon での参照可否 

2) Alma の IZ で登録した書誌及び所蔵データの Primo：NZ/Summon での参照設定

手順 

(2) 検証時に利用した Alma のメニュー項目 

PrimoがAlma IZを直接参照することは不可能なため、以下の手順で Primo/Summon

との連携を実現する。 

1) Alma IZ で所蔵登録して Alma NZ に反映する。 

Create Inventory > Add Local Electronic Collection 

Create Inventory > Add Local Portfolio 

Create Inventory > Add Physical Item 

2) Alma NZ から Primo/Summon へレコードを Publish し、Primo/Summon か

ら Alma NZ の参照を可能にする。 

a) Primo の場合 

Resource Management > Resource Configuration > Configuration Menu 

> Record Export > Publishing Profiles 

b) Summon の場合 

Resource Configuration > Configuration Menu > Record Export > 

Publishing Profiles 

(3) 検証結果 

1) Primo/Summon から Alma NZ を参照することは、Primo/Summon からレコ

ードを Publish することで行う。ただし近々リリース予定の Primo VE では Alma

のレコードを直接検索するようになるため Publish は不要になる。そのため現在

の検証環境での検証は行わない。 

2) Primo VE がリリースされると Publish の手間がなくなり、Alma のシームレスな

連係が期待できる。 

3) Alma IZ から直接 Summon へ情報を送ることは出来ないが、Alma NZ 経由で可

能であることがわかった。 

(4) 機能評価 
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評価：B 

 

Primo/Summon 日本語等のインデキシング精度 

(1) 主な検証内容 

1) Primo/Summon から Alma IZ のデータを参照した際の日本語等の取り扱いにつ

いて、ソート順の確認等を通じて一般的な使用に耐えうるものかどうかを明らか

にする。 

(2) 検証時に利用した Alma のメニュー項目 

1) Portfolio の作成 

RESOURCE MANAGEMENT > Create Inventory > Add Local Portfolio 

2) MD Editor の起動 

ポートフォリオの新規作成後、タイトルをクリック > Edit 

(3) 検証結果 

Primo で Alma のデータを検索し、結果をタイトルでソートした場合、CJK について

は UTF-8 の文字コード順にソートされる（※Ex Libris 社へのヒアリングによる）。 

Summon に関しては回答無し。 

1) Portfolio の新規作成時に Alternative Title 1 または 2 に翻訳タイトルを入力す

ると、MARC field 246 に追加され、PNX の sort セクションのタイトルにマッピ

ング可能である。ただし MARC21 での目録作成では、OCLC/LC の目録作成規則

を使用するため、MARC Field 880 に格納される。 

2) Create Inventory > Add Local Portfolio を使用して Portfolio を作成する場合

は、漢字でのみタイトルを作成し、MD Editor でレコード編集することを Ex Libris

社は推奨している。 

(4) 機能評価 

評価：C 

(5) 改善への提言 

1) 例えば『図書館を変える! ウェブスケールディスカバリー入門』というタイトルの

資料が、「図書館」をキーワードにして検索してもヒットしないが「図書館を」を

キーワードにするとヒットするような例が見られたため、日本語等の扱いに関し

て改善を検討していただきたい。 
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13 ユーザーからの問合せ対応/パッケージタイトル変更（随時） 

(1) 主な検証内容 

1) クレーム管理 

(2) 検証時に利用した Alma のメニュー項目 

1) 利用者からのクレーム管理 

2) 業者へのクレーム管理 

3) Primo への反映 

(3) 検証結果 

1) 利用者からのクレームや要望の管理 

利用者は、Primo フロントページの電子メール連絡先アドレス、または連絡先フォ

ームへのリンクを持っているので、そこから図書館に連絡することが可能である。

チャットボックスを使用するライブラリもある。利用者からのクレームは、利用者

ごとに、ユーザーアカウントの[Notes]タブでメモを残すことができる。また、リ

ソースごとに、電子コレクションまたはポートフォリオの[Notes]タブでメモを残

すことも可能である。 

2) 業者へのクレーム管理 

インシデントは、Vendor アカウントの[Notes]タブ（または電子コレクションま

たはポートフォリオのメモ）に記録できる。インシデントにより、POL を閉じるこ

と も 可 能 で あ る 。 POL Details の Communications タ ブ か ら 、 Start 

Communication を Create し、プルダウンメニューから Incident や Claim など

を選び、取次書店とのやりとりを記録に残し、POL の存否判断の材料にできる。 

3) Primo への反映 

Customization Package manager を使い、html で利用者に向けての周知メッセ

ージを Primo に反映することができる。特定の電子コレクションまたはポートフ

ォリオが利用できないことを利用者に通知する場合は、電子コレクションまたは

ポートフォリオの Public note フィールドを使用することができる。リソースの公

開名を一時的に変更することもできる。 

(4) 機能評価 

評価：B 
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(ウ) 購読誌の分析・評価 
 

概要 

 

Alma の統計・分析モジュールは、Oracle Business Intelligence（以下，OBI）をベース

として構築されている。OBI とは、業務システムなどに蓄積されるデータを蓄積・分析・加

工し組織の意思決定に活用するためのシステム及び手法を指す。デフォルトで用意されて

いる帳票類、統計出力のためのテンプレートの他、OBI の機能を流用して新たな業務分析

のためのテンプレートを追加することも可能となっており、日本の一般的な図書館システ

ムに実装されている統計・帳票機能より強力である。 

貸出冊数・目録リスト・受入件数/金額等、基本的なデータについて十分網羅されている

ほか、関連業務画面上でグラフを表示する（例えば閲覧関連業務画面上に、貸出冊数の状況

を表示する）機能を備えており、図書館の利用状況をリアルタイムに確認しながら、業務に

携わることが可能となっている。 

日本では各機関が発行する報告書、大学概要のほか、図書館協会等へ提出する資料等、あ

る程度項目（書式）が決められたものが存在するが、現状では恐らく各機関の担当者が各々

データ処理・加工を行って提出しているものと思われる。日本でコンソーシアム導入する場

合、全国共通のフォーマットについてテンプレートを共有することで、業務を大幅に省力化

できる可能性がある。その他、経営分析的なレポートを共有することで、コンソーシアム（ま

たはコンソーシアム外コミュニティ）に参加した他機関との比較を効率的に行うことも可

能である。統計機能については、ExLibris 社の開発者サイト等で活発な議論、API 開発が続

けられており、今後も様々な機能追加が期待される。 

導入時には、従来、システムに蓄積されたデータを加工して統計値を公表している機関に

ついては、その処理過程の移行方法に留意が必要である。機関によっては現行システムの統

計帳票フォーマットが必須のケースもあると思われるので、システム移行（カスタマイズ構

築）の際に必要なレポートの雛形作成を導入仕様書に含めておく等の配慮も必要である。 

トライアルについては、トライアル用のデータを初めから POL に作成するため、契約ま

で同じデータを使用でき、また、設定項目も最低限備わっており、管理がスムーズである。

ただし、特定の参加者からの回答を分析したいときには、トライアル参加者の個別設定が必

要となるため、分析のための相応の準備がかかる。 
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総合評価 

 

A
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14 利用統計の取得 

(1) 主な検証内容 

1) 利用統計の内容精査 

2) 利用分析の内容精査 

3) コンソーシアムに特化した統計機能の確認 

4) コンソーシアムに特化した参照機能の確認 

(2) 検証時に利用した Alma のメニュー項目 

1) 利用統計・分析の内容精査 

a) ADMINISTRATION > Analytics > Design Analytics 

b) メニューバー > Analytics>Analytics > Reports 

2) コンソーシアムに特化した統計機能の確認 

a) ADMINISTRATION > Analytics > Design Analytics > * > Institutions 

b) ホーム > 分析 > * 

3) コンソーシアムに特化した参照機能の確認 

c) Configuration > Analytics> Institutional Analytics Profile 

(3) 検証結果 

1) 利用統計の内容精査 

a) 業務画面からすぐに利用統計（表、グラフ）を表示可能であり、日常のワーク

フローの中で、即座に利用状況を把握することができる。 

b) Analytics メニューの下に業務毎のテーブルをフォルダ階層で整理しており、

業務画面に出力する統計表のデフォルトデータは、全てこの中に登載されて

いる。 

c) 機関側で利用可能な統計データは Alma Analytics モジュール内に用意されて

いる。 

d) 国内の業務パッケージに含まれる、受入・蔵書・閲覧・ILL に関する基本的な

統計表は網羅している。 

e) Alma Analytics モジュール内で、各テーブルともフィルタリングやパラメー

タの変更を行ってデータ抽出を行うことが可能である。 

2) 利用分析の内容精査 

a) Alma の Analytics モジュールは、Oracle Business Intelligence（OBI）をベ

ースに構築されており、多数の業務分析用レポートが予め実装されている。 

b) 一例として Cost Usage というテーブルが用意されており、この中にコレク
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ション使用に関する様々なファクトデータが収められている。 

c) 使用コストの分析レポートの例として、月次使用量、出版社毎の平均使用量、

頻繁にアクセスされるデータベース、ジャーナル、電子コレクションの年間使

用単価等を出力可能である。数値だけでなくグラフも同時に画面に表示され

る。 

d) Alma に含まれる全フィールドが Analytics に抽出されるわけではない。 

e) 抽出されるデータは、Ex Libris 社が統計・分析に必要と判断したデータのみ。 

f) Analyticsで出力されるレポートのカスタムレポート作成を用意にするために、

Design Analytics > Catalog 以下のサブジェクトエリアに、レポートで使用

するものと同じデータが抽出されている。 

g) 統計目的以外により完全なデータ抽出を行うための API が用意されている。 

h) API 利用については Ex Libris 社の Developer Network サイト等に情報が

集められており、このサイトでアカウントを取得してログインすると API 呼

び出しを行うための Web アプリケーションを利用可能である。また、この

Web アプリケーションから自機関 Alma 環境へのアクセスが可能である。 

i) Tableau（タブロー＝データ視覚化ツール）と連携するための API も用意され

ている。 

3) コンソーシアムに特化した統計機能の確認 

a) NZ からアクセスした場合のみ Analytics メニュー以下 OBI 画面へ変遷した

後、「Institutions」が表示され、ここに NZ からの統計・分析データが出力さ

れ、コンソーシアム参加機関を比較する統計、分析が可能である。 

b) 例えば OBI の機能を用いて「Institutions」と分析したい項目を設定し、結果

表示させると統計データが出力される。設定結果は共有フォルダ内に保存可

能である。 

c) NZ からアクセスした場合は NZ からの分析に特化されるため、IZ 単位のレポ

ートは表示されない。 

d) 「機関名+調査したい項目」の設定を保存しておくことで、次回以降、同条件

ですぐにデータ抽出が可能であり、NZ 内の各機関の契約状況調査は十分可能

である。 

e) カタログ > 共有フォルダ > Industry Statics フォルダ内に ARL 等へ提出

するレポート（電子資料数、物理資料数、図書毎の所蔵数、貸出数等）のサン

プルが自動抽出される設定が保管されている。 

https://developers.exlibrisgroup.com/
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4) コンソーシアムに特化した参照機能の確認 

a) Analytics モジュール内に Alma フォルダ・ローカル機関フォルダ・コミュニ

ティ用フォルダが用意されており、それぞれの用途に応じて利用できる。 

b) 各機関独自に作成したレポートは他館からは参照できない。 

c) NZ 内にコンソーシアム単位で作成したデータがあれば、参照可能である。 

d) IZ が作成したレポートであっても、Analytics モジュールの共有フォルダに置

くと、コンソーシアム間で参照可能である。 

e) 自機関のプロファイル設定で集計データの匿名化を行うことが可能である。 

f) 匿名化され、かつ集計されたデータは、機関と同じ地域のデータセンター内で

のみ使用される。 

(4) 機能評価 

評価：A 

(6) 導入時の留意点 

1) 経年蓄積された統計データをどのように移行するか、場合によっては機関毎に事

情が違うケースも考えられるため、移行計画に留意が必要である。 

2) 必ずしも「現行図書館システム内のデータ」がそのまま使用されているとは限らな

い（公開している統計値とシステム内の実数が不一致の）ケースがあるので、統計

業務に関する運用をどのように変更するか、機関毎に見直しが必要である。 

3) パッケージ標準の統計表は使用せず、別途 SQL 抽出したデータを元に統計表を作

成する、等の運用を行っている機関もあると思われるため、こうした個別の案件に

ついても検証が必要だが、基本的には運用回避できるものと思われる。 

4) 機関によっては、Alma 移行後も現行システムの統計帳票フォーマットが絶対に必

要、というケースもあると思われる。システム移行（カスタマイズ構築）の際に必

要なレポートの雛形作成を導入仕様書に含めておく等の配慮も必要がある。 

5) 現場からは、自分の業務に関連する項目は全て抽出した上で Excel 等で加工した

い、という要望があがるのではないかと思われる。OBI を用いた業務運用に変更し

てもらう方向が良いと思われるが、移行期には、予め必要になりそうなデータ項目

を調査して、抽出するための手法（API 利用手順等）を整備しておく必要があるか

もしれない。 

6) 図書館協会等へ提出する統計の他、会計検査への対応等においても他機関との比

較データが必要となるケースがあるが、NZ からの統計・分析機能を活用すること

で業務を大幅に省力・効率・高度化できる可能性がある。他機関との比較を容易に
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行える環境があれば、サービスの見直しや蔵書構築計画等についても、より効果的

に行える可能性が高い。コンソーシアム導入の際、全国で使える汎用的なサンプル

レポートを初期導入しておきたい。 
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15 購読金額の調査 / 16 費用対効果の算出 

(1) 主な検証内容 

1) 購入検討のための分析 

2) 購入後の所蔵・購入結果の分析 

3) 帳票の内容精査 

(2) 検証時に利用した Alma のメニュー項目 

1) 購入検討のための分析・帳票の内容精査 

a) ADMINISTRATION > Analytics > Design Analytics 

b) メニューバー > Analytics > Design Analytics > カタログ > 共有フォル

ダ >  * > Reports 

2) 購入後の所蔵・購入結果の分析 

a) Resources > Advanced Tools > Overlap and Collection Analysis > カタ

ログ > 共有フォルダ > Titles > Reports > Overlap* 

b) Acquisitions > Funds and Ledgers 

(3) 検証結果 

1) 購入検討のための分析 

a) Overlap and Collection Analysis という機能が実装されており、電子・冊子

体に関わらず同一タイトル（タイトル or ISSN・ISBN）での重複分析が可能

である。 

b) IZ 内の他、NZ・CZ 内のタイトルとの重複チェックが可能である。 

c) 出版社・データベースパッケージ・ポートフォリオ等からなる「Source set」

という単位を作成し、この単位による重複チェックを行うことができる。 

d) CZ・NZ 等と比較して IZ に存在しないタイトルや、逆に手元のリスト（ロー

カルファイル）と照合して CZ・NZ に存在しないタイトルをチェックするこ

とも可能である。 

e) 「タイトル・著者・利用回数」について同一タイトルの電子版・冊子版を比較

した統計データ・帳票を出力可能である。 

f) POL・書誌情報テーブルからのデータ抽出が可能である。 

g) パッケージのコスト・使用回数・１会計年度あたりの使用コストの抽出が可能

である。 

2) 購入後の所蔵・購入結果の分析 

タイトル重複状況については、下記のように様々な観点から分析できる。 
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a) IZ 内の同一のカバレッジの一致タイトル 

b) IZ 内の部分的にカバレッジが重複しているタイトル 

c) 相互に排他的な IZ とのマッチングタイトル 

d) 作成したソースセットに固有の IZ ゾーンのタイトル 

e) IZ に複数回存在するタイトル 

f) IZ に１つだけ存在するタイトル 

g) IZ データベース内に一致するものがないタイトル 

h) CZ に存在するマッチングタイトル 

i) CZ に存在しないタイトル 

j) IZ の電子リソースと外部 Excel ファイルとの比較 

k) CZ の電子リソースと、Excel ファイルとの比較 

l) Acquisitions メニュー > Funds and Ledgers 画面等に、発注単位毎の予算、

支出残高をグラフ込みでレポートを表示する機能が実装されており、購入状

況等についてリアルタイムで大まかな状況を確認することができる。 

m) 重複タイトル分析に含まれる項目は、タイトル・MMSID・ISBN（ISSN）で、

個別のタイトル毎の金額等は含まれないため、電子版と冊子版の同一タイト

ルをワンオペで比較するような操作は行えない。重複データ抽出後、契約情報

を確認するかもしくはファクトデータ抽出後、Excel 等外部ツールで分析する

等して対応することになる。 

n) 契約先・媒体別・分類（Dewey、LC Classification）別で、年度毎の支出額の

出力が可能である。 

3) 帳票の内容精査 

a) 統計データは Analytics モジュール上での画面表示の他、PDF・Excel・ppt、

テキスト（CSV・タブ・XML）等多様な形式で出力可能である。 

b) 画面上でグラフが表示されている場合、そのグラフィックについても同様に

PDF・Excel 等の形式で出力される。 

c) 国内図書館業務システムに見られるような、様式を整えたレイアウト（ヘッ

ダ・表・グラフ等）での帳票ではなく、データを一覧する Excel とグラフがそ

のまま画面に出力されている。 

d) 学内の定められた様式がある場合、Excel で出力した後、整形するなどの運用

が必要である。 

e) 業務上使用する項目は全て API を用いて抽出可能なため、仮に Analytics か
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らすぐに抽出できないフィールドがあった場合でも、データ抽出後に表計算

ソフト等で加工する運用は可能である。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) 簡単な操作でコレクションの重複分析が可能な機能を有しているが、キーとなる

識別子が、ISSN・ISBN・タイトル・LCCN となっている。日本が導入する場合、

この他に必要な番号がないか検討の余地がある。（例：NII 書誌 ID、全国書誌番号

等） 

2) 分類別の購入・蔵書分析が可能であるが、Dewey、LC Classification であるため、

NDC 他、日本で利用可能な分類をこれに加えた方が良いか検討する必要がある。 

(6) 導入時の留意点 

1) 既存の ILS 等から移行する場合、帳票関係のフォーマット・レイアウト変更がど

の程度許容されるのかは機関毎に事情が違うと思われる。 

2) 帳票の様式について、項目・レイアウトとも、必須の要件とそうではないものとを

整理しておき、必須のものについては仕様策定の上、初期導入することを検討した

方がよい。 
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17 評価・シミュレーション資料の作成 

(1) 主な検証内容 

Alma を用いたトライアル管理の可否について検証した。 

1) トライアル用データの作成・開始 

2) トライアル結果の分析 

3) トライアル後の流れ 

(2) 検証時に利用した Alma のメニュー項目 

Acquisitions > Purchase Order Lines > Search for PO Line 

Acquisitions>Purchase Order Lines>Manage Trials 

Resource Management>Search>Repository Search 

(3) 検証結果 

1) トライアル用データの作成・開始 

a) Alma では、トライアルは Evaluation Workflow の一つとみなす。 

b) CZ の Search for PO Line でヒットした当該資料データから新規 POL を作成

し、「Save and Request Evaluation（※1）」もしくは「Save and Start Trial

（※2）」を選択することで、Trial Details 画面に POL が表示される。これに

より、PO L と連携したトライアル用データが作成できる。POL 側の Status

は Under Evaluation となり、評価中であることがわかる。 

※1：Purchasing Operator に Trial Operator/Trial Manager の Role 割当が

ない場合 

※2：Purchasing Operator に Trial Operator/Trial Manager の Role 割当も

ある場合 

c) Trial Details 画面で編集/保存したトライアルタイトル Acquisitions > 

Purchase Order Lines > Manage Trials で Trial List として表示され、ここ

から各トライアルの Trial Details 画面の編集が可能となる。トライアル設定

項目は以下のとおり。 

 トライアル名（必須） 

自由に名称を設定可能 

 トライアル期間（必須） 

Start Date、End Date を設定 

 トライアル提供範囲 

デフォルトではトライアル参加者（ユーザー管理画面で登録）を一人ずつ
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設定する Private が選択され、Available to public にチェックすると全体

へ公開 

 トライアル料金（有料の場合） 

Trial Details 画面には入力欄なし 

 トライアルコンテンツの設定 

パッケージの場合、POL の portfolios で対象タイトル選択可能 

 トライアル通知 

Private の場合は、各参加者へ自動通知メールの送信が可能（アンケート

調査も可能）。Trial 通知用のメール送信機能を使用するには Monitor Jobs 

page で job を Active にする必要がある（※検証環境の制約により未検

証）。Available to public の場合は、従来どおり別途ホームページやメー

ルでのトライアル案内が必要となる。自動作成（編集不可）される

Participant Page URL からトライアル利用してもらう。自動通知メール

内容は Alma Letters > Trial Letter で編集可能。 

 Attachments・Notes タブ 

関連ファイルの保存やその他情報の記載が可能。 

2) トライアル結果の分析 

Private 設定で個別の参加者にアンケートメールを送信した場合は、Analysis タブ

から回答結果の表やグラフが自動作成される（※検証環境の制約により未検証）。

分析後の導入判断結果について、Analysis and Result 欄（項目：Result/Result 

Date/Result Reason（管理者がリスト定義）/Purchase Decision）に記入し保存

可能できるほか、分析結果の詳細はエクセル形式でも出力可能である。 

3) トライアル後の流れ 

a) 導入を決定した場合、当該資料の POL を使用して発注・契約に進む。 

b) 導入を見送る場合、当該資料の POL のキャンセルをする。 

(4) 機能評価 

評価：B 
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(エ) 電子ブックの発注/支払 
 

概要 

 

電子ブックの発注/支払は、冊子体の場合と同様の手順で行うことが可能。PDA(DDA)/STL

管理が可能となっているが、現時点では情報として記載できるだけで PDA を提供するサイ

トと直接連携するものではない。請求/支払は EOD を介して行われる。 

 

総合評価 

 

B
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18 電子ブックの発注/支払 

(1) 主な検証内容 

1) モノグラフやシリーズにおける新刊購入（出版情報との連携）の手順 

(2) 検証時に利用した Alma のメニュー項目 

1) Resources > Cataloging > Open Metadata Editor 

(3) 検証結果 

1) 出版情報との連携については、API や CZ などを通じた書誌の流用やダウンロード

にとどまる。 

2) 継続発注（スタンディングオーダー）による電子ブックの新刊購入については、冊

子体の場合と同様の手順で行える。 

3) 最初に非表示の発注用書誌レコード（例：○○研究所からの全ての出版物など）を

作成し、POL の作成時に Purchase Type を Standing Order – Electronic とする

ことで、対応可能である。 

4) 発注先はこの継続発注というオープンオーダーに応じて、開通の手続きを行う。開

通の手続きがなされたタイトルについては、発注先からの連絡が入り次第、図書館

側で Activate の手続き、あるいは確認を行い、支払いのフローに移る。 

5) 新規に登録された図書については、該当する electronic portfolio の Acquisition 

Information の POL に、POL Number を登録することで、POL へのリンクを作成

し、管理することになる。 

(4) 機能評価 

評価：B 
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19 PDA（DDA）/STL 管理 

(1) 主な検証内容 

1) ウェブサイト上での利用者の購入フローとの連携 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Advanced Tools > Patron Driven Acquisition (PDA) 

(3) 検証結果 

1) 最初に PDA の概要を登録する。Threshold の欄はいずれも情報として記載できる

だけで、直接 PDA を提供するサイトと連携するものではない。 

 

 

 

 

 

 

 

 

 

 

2) 登録した概要から Manage PDA Profiles を選択し、その後の「○○ PDA 

Repository」というプロファイルのメニューRun Import から、PDA の対象とな

る図書のリストをアップロードできる。その前にプロファイルの中のフォーマッ

トなどの設定が必要である。なお、あらかじめ portfolio が用意されていれば使用

可能である。 
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3) インポートにより、対象となる図書を Primo や Alma に表示可能になる。 

4) 請求については EOD を介して行われる。事前に EOD のマッピングを正しく行う

必要があるが、ベンダーから購入に至った図書があれば New Order のプロファイ

ルの Job History の中で確認できる。この時点で POL も自動作成される 

5) PDA の終了後、購入がなかった図書については、Cleanup というコマンドを使う

ことで、書誌を Summon/Primo から一括で削除できる。 

(4) 機能評価 

評価：C 

(5) 改善への提言 

1) 日本の代理店などでの EOD の利用促進などが必要である。 

2) 現段階では日本国内の電子ブックサイトにおいて PDA は行われていないが、この

ような事例が出現した場合については、提供される書誌のフォーマットがどのよ

うになるか注視し、できる限り対応できるようになることが望ましい。 
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≪ネットワーク連携業務≫ 
(オ) Institution Zone（IZ） / Network Zone（NZ） / Community 

Zone（CZ） 
 

概要 

 

 Alma では、各機関の業務を行うための Institution Zone（IZ）、コンソーシアム等を形

成する複数の機関が共通する業務を行う Network Zone（NZ）、全世界の Alma ユーザーが

データ共有するための Community Zone（CZ）の３つの領域があり、それぞれが連携して

いる。本検証では、NZ を JUSTICE 相当のコンソーシアムであることを想定し、ナレッジ

ベース、メタデータ、ライセンス等のデータ共有機能の確認を行った。IZ/NZ/CZ の連携に

よって、各機関における重複作業の削減や共有されるデータの品質向上が期待できるため、

業務の軽量化・合理化に繋がる可能性を持った仕組みであることがわかった。一方これを効

果的に機能させるためには、NZ（コンソーシアム）レベルでのデータ共有モデル作成や、

場合によってはコンソーシアム固有の機能をサポートするための API を利用した付帯シス

テムの開発も必要となることがわかった。 

 

【書誌データ・メタデータの環境】 

Alma の CZ には、CKB（セントラルナレッジベース）の他、LC・NLM・GND（ドイツ国

立図書館）等、世界的な機関の書誌ファイルが組み込まれている。CKB については週次で

更新されており、情報の鮮度に問題はない。CZ の共有方法や、IZ 内のメタデータの管理方

法も非常に洗練されている。電子資料のメタデータが充実しており、海外における Alma 導

入機関の所蔵資料が既に電子中心となっていることの一端が見て取れる。 

なお、 Ex Libris 社はメタデータの取得のために各ベンダーと個別に契約しているため、

未契約ベンダーが所有するデータは提供されない。またベンダーによっては十分なメタデ

ータが提供されないケース、タイムリーな更新が行えないケース、コンソーシアムでの共有

が出来ず、特定の機関でしかメタデータの利用が出来ないケースもある。これらは全て契約

条件に依存するものであり、日本に Alma 導入するにあたっては、ベンダー由来のメタデー

タの契約条件等を整理しておく必要があるだろう。 

NZ で共有される書誌データの作成、品質管理等が重要であることはこれまでと変わるこ

とはないが、CZ の部分は完全に Ex Libris 社で管理されることから、維持費や人的リソー
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スとも、運用コストの大幅な削減が期待されるところである。これについては別途、導入経

費や運用体制について検証しておくも必要ではないかと思われる。 

 

【メタデータ共有機能】 

メタデータの共有に関して、複数館での共同運用に適した機能が備わっている。特に機関ゾ

ーンとネットワークゾーン間は「Share」と「Copy」を使い分けることで、同期させるメタ

データと機関内でのみ利用するメタデータを分けることが可能である。同期する場合にお

いても、機関ゾーンでのみ追加する項目を設定できるなど、ネットワーク内で共同利用する

メタデータモデルに効果的な機能を有している。 

 

電子リソースのメタデータ共有について、国内において単館で導入する場合、CZ から IZ へ

のデータは、十分な機能を有していると思われる。ただし、実際のコンソーシアム運用に際

しては、JUSTICE のタイトルリストを NZ にインポートして詳細を検証する必要がある。

CZ から NZ への共有機能については CZ から IZ と同様に行うことができる。 

 

【API によるシステム連携】 

Alma は、そのなかにすべてを取り込むのではなく、Alma 内でやること（Acquisitions、

Fulfillment、Resource Management、Analytics）とそれ以外を分け、それ以外の発展的

なサービス、周辺システムは Alma 外で連携できるよう設計されている。例えば、Alma 内

で管理する各種データを API を通じて利用可能にできる点、その範囲や種類について詳細

に設定できる点は評価できる。統計機能はその出力項目を設定できるため、データ出力とし

ても利用することができる。ただし、データ形式が XML や JSON が基本であるため、連携

できるシステムや扱える人材が限定される可能性もある。 

データ出力の汎用性が高いことは、設定が複雑であるということでもある。Primo や

Summon へのメタデータ出力はメニューとして用意してあるため、比較的容易に設定でき

る。教務システムや自動書庫なども、デフォルトでセットされたシステムを選択できれば、

同様である。しかしながら、国内ベンダーの製品は Alma の設定画面でメニューとして用意

されていない。それらの製品が国際標準に準拠していない（自動貸出機や EDI など）こと、

日本のマーケットがまだ大きくはないため、開発の視野に入っていないためだと考えられ

る。現状では XML や JSON、あるいは統計機能をつかってテキストデータを出力し、各シ

ステムに投入するという運用になると思われる。国内ベンダーとの協力を得ることができ

れば、Alma とその周辺システムとの相互運用性を改善できる可能性がある。 



 別紙  

44 

 

 

総合評価 

 

C 
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20 Network Zone (NZ) 

(1) 主な検証内容 

1) Network Zone の管理権限についての検証 

2) Network Zone のみの契約の可否 

3) API の利用コスト 

4) 1 契約で NZ の複数作成可否 

(2) 検証時に利用した Alma のメニュー項目 

なし 

(3) 検証結果 

1) 開設及び参加機関(Institution)の指定は Ex Libris 社に要請して付与してもらう必

要がある。 

2) Network Zone のみの契約の可否 

a) NZ のみの契約自体は可能だが、Acquisition のための作業グループを作る必

要がある。 

b) NZ のみの運用の事例はいくつかあるが、ほとんどの地域はそれぞれ個別の

Institution アカウントを持ったうえで NZ に参加している。 

c) Single Institution という、地域で IZ をひとつだけ契約し、擬似的に NZ のよ

うに運用する方法がある。単科大の集合体や姉妹校が各地にある大学等、

Small Consortia で使われているが、所蔵データの共有や各大学の所蔵先の細

分化ができないため、Ex Libris 社としては推奨していない。各機関の Fund

等も見ることができてしまうため、見られても問題ない機関同士の利用に限

られる。 

d) 電子リソースやライセンス管理だけに使用するだけなら、（ウ）の疑似 NZ と

して構築した IZ、または Alma 以外のサーバーに当該情報を格納し、各機関

はエクスポートして利用する、という運用を Ex Libris 社は推奨している。 

3) API の利用コスト 

利用数における追加コストはないが、ユーザー数によって利用回数に制限がある。

特定の時期に一時的に利用回数を増やすという対応も可能である。 

4) 1 契約で NZ の複数作成可否 

A 大学が、B 大学との共同運用による NZ：C を持つのと同時に、例えば別の NZ：

D にも参加する、ということはできない。 

(4) 機能評価 
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評価：B 

(5) 改善への提言 

1) 開設は Ex Libris 社が行えば十分であるが、参加機関の追加・修正等は NZ 管理者

が行えることが望ましい。 
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21 ナレッジベース 

(1) 主な検証内容 

1) Alma が持つ Central Knowledge Base（以下、CKB）の質と量に関する確認 

(2) 検証時に利用した Alma のメニュー項目 

1) Resource Management > Repository Search > Manage Inventory 

2) Resource Management > AdvancedTools  > Overlap and Collection 

Analysis > Duplicate Title Analysis 

(3) 検証結果 

1) CKB と CZ の運用 

a) Alma の CKB は、Ex Libris 社と電子リソースを提供するベンダー間で個別に

交渉及び CKB・CZ への登録が行われるが、事情により登録されないケースも

ある。 

b) Alma 利用機関は CZ のメタデータを直接作成・更新することはせず、NZ・IZ

へのコピーカタロギングを行って使用する。CKB は週次で更新される。 

c) 各機関は、CZ にメタデータを追加するように要求することができるが、最終

的な決定権は Ex Libris 社にある。 

d) 日本でもすぐに使用可能なメタデータが CZ 内に既に登録されており、例え

ば、JUSTICE によって導入された電子コレクションも CZ 内に存在する。 

e) CZ には原則的に電子リソースのメタデータのみが存在するため、CZ 及び

CKB での冊子体の書誌データ共有は適さない。 

2) CZ とのデータ照合 

a) Excel のタイトル一覧を読み込んで CZ との照合を行うことが可能である。 

b) Resource Management > 以下、Overlap and Collection Analysis から重

複レコードのチェックができる。結果は Excel ファイルで受け取ることがで

きる。 

c) Community Zone Updates Task List に CZ からの更新中に IZ に加えられ

た各機関固有の更新が表示される機能が用意されているため、ローカル情報

の更新管理についても問題なく、情報が不必要に上書きされたり、更新すべき

内容が放置されたりといった齟齬が発生しない工夫がなされている。 

3) CZ にないデータの作成 

a) CZ に存在しないが、日本の図書館に関連するコレクションが必要な場合は、

Ex Libris 社に導入の交渉を行うことは可能である。 
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b) CZ 内で必要なコレクションを利用できない場合は、NZ・IZ にメタデータを

インポートまたは作成してローカルコレクションを作成できる。 

c) 作成したコレクションは CZ へ提供を申し出ることができる。ただし、提供さ

れたデータが採用されるかどうかは Ex Libris 社側のガイドラインに依る。 

4) 所蔵情報の共有 

a) 所蔵データは各機関固有であり、ある機関 A は別の機関 B の所蔵データにつ

いて、Primo を利用した参照は可能だが、Alma での管理・編集はできない。 

(4) 機能評価 

評価：B 

(6) 導入時の留意点 

1) 国内で生産され、Alma の CKB に収録されないメタデータがどの程度発生するか

留意する必要がある。冊子体については NACSIS-CAT からのインポート、電子に

ついては ERDB-JP に日本の電子リソースを集約して Alma に渡すことで、どの程

度国内のリソースをカバーできるか等。その他、国内出版社からのデータ提供の協

力を促したい。 

2) 前項について、データインポート等で補う必要がある時は、そのデータソースの確

保・整備とインポートまでのフローについて検討しておく必要がある。例えば、CZ

への登録に関して Ex Libris 社と交渉する窓口、コンソーシアム導入の場合、NZ

で共有するデータの品質管理をどのように行うか等。 
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22 メタデータ 

(1) 主な検証内容 

1) メタデータフォーマット 

2) インポート作業 

(2) 検証時に利用した Alma のメニュー項目 

1) Resource Management > Create Inventory > Manage Inventory 

2) その他、「MD Editor」や「Edit Portfolio」の編集画面等 

3) Administration > General Configuration > Configuration Menu > External 

Systems > Integration Profiles 

4) Resources > Create Inventory > Add Local Electronic Collection 

(3) 検証結果 

1) 基本情報 

a) メタデータは KBART や Dublin Core にも対応しているが、記述フォーマッ

トの基本は MARC21 形式。 

b) 冊子体・電子・デジタル（自機関でデジタル化した資料）を管理可能である。 

2) メタデータに含まれる情報 

a) CKB のメタデータは、書誌的情報の他、管理/アクセス情報、電子ジャーナル

タイトルのカバレッジ情報、その他の記載事項（ノート）等が含まれる。 

b) CKB・CZ・NZ に、各機関固有の APC 等、契約・会計に関する情報や出版者

変遷等の情報は含まれない。 

c) IZ にコピーして、契約情報等の１つとして各機関が個別に記録して使用する。 

3) 媒体別のメタデータ項目 

a) 冊子体は所蔵（Holding）、電子は、Portfolio からアクセス（URL 等）情報へ

リンクする。 

b) 1 つの書誌に複数（冊子体とデジタル）の所蔵・アクセス情報をリンクするこ

とも可能である。 

c) Portfolio の項目は、契約期間・リンク情報・Coverage Information・契約情

報・ノート（ローカル記述欄）等の管理情報が登録可能である。 

d) 書誌情報以外では電子リソース（URL）、Linked Data 等を扱うことが可能で

ある。 

e) CZ→NZ→IZ とカスケードされるが、上流において必ずしも全ての項目が網

羅されているわけではない。 
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4) フォーマット 

a) 書誌データは MARC21（RDA 拡張機能あり）、UNIMARC、KORMARC の書

誌所蔵、Dublin Core 全項目等、世界的に標準とされているフォーマットにつ

いてはすべて対応済である。 

b) その他のフォーマットについても、インポート用のプロファイルを作成して

取り込む機能が実装されている。 

c) OCLC はインポートプロファイルが準備されている。 

d) 現時点で NACSIS-CAT は含まれていないが、インポートは可能。MD Editor

から、外部リソース検索等を行い、書誌データを呼び出す機能が実装されてお

り NACSIS-CAT との連携が実現した場合、この機能を用いて目録作成する運

用になると思われる。 

e) KBART についても対応済である。機能の実装例として、Elsevier、Ovid 等出

版社からの雑誌情報（Portfolio）を KBART 形式で継続的に自動更新するメニ

ューが実装されており、機能的には問題ない。これに ERDB-JP を加えること

については、電子リソースデータ共有作業部会として Ex Libris 社との調整・

交渉を開始する準備を始めたところである。 

f) 所蔵データは、MFHD（MARC21 Format for Holding Data）、Linked data

（リンクされたデータは全て JSON-LD 形式で公開する必要がある）に対応

済。 

g) Linked Data のデフォルトの情報は JSON-LD の@context フィールドで、

こ れ は https://open-na.hosted.exlibrisgroup.com/alma/contexts/bib 

に対応している。これ以外のコンテキストを使用したい場合も、対応する URL

があれば、設定画面に記述することで変更可能となっている。 

5) インポート方法 

a) CZ・NZ で利用しない場合、各機関が独自にインポート可能であり、これには

Ex Libris 社の仲介は必須ではない。各機関は作成したプロファイルを用いて

継続的かつ自動的にインポートを行うことができる。 

b) 単にインポートするだけでなく、レコードの正規化・検証・重複チェック・マ

ージ等（チェックは各機関のレコードに対して行われる）、レコードの品質を

維持するための機能が実装済である。 

c) インポート時の検証機能の動作については、ルールに従って強制インポート・

インポートしない・エラーレコードの出力等のオプションを選択でき、各機関
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の事情に合わせた運用を行うことが可能となっている。 

6) 国内 MARC 

a) NACSIS-CAT（CATP） 

Alma は CATP に対応していないため、MARC21 に変換し、NZ に一括登録す

ることで共有することが可能である。VOL 積みの書誌は、Alma に投入される

と VOL 積のまま登録されるため、運用を検討する必要がある。Alma では

MARC21 の 245 （ Title Statement ） と 880 （ Alternate Graphic 

Representation）が、245 に集約される。その結果、検索結果一覧で優先的

に表示されるのは、245 の上位になるため、和書の場合、ローマ字表記のタイ

トルが検索結果一覧に優先的に表示される。 

b) JAPAN/MARC 

新刊について MARC21 形式であるので、NZ に一括登録することで共有する

ことが可能である。タイトルについては NACSIS-CAT と同様の事象が発生す

る。 

c) TRC/MARC 

NACSIS-CAT と同様に、MARC21 に変換して NZ に一括登録することで共有

することが可能である。タイトルだけでなく、著者名と出版社名とシリーズ名

と件名もローマ字表記が上位にセットされる。 

(4) 機能評価 

評価：B 

(6) 導入時の留意点 

1) コンソーシアム導入を念頭におくと、初期構築時にインポートに必要なプロファ

イルのテンプレートをいくつか用意しておく必要がある。 

2) インポートファイルには 10MB のサイズ制限がある。これを超えるサイズを定期

的に処理する必要がある場合、FTP サーバー経由での処理を行う必要があるため、

このためのサーバーをどう確保、維持するのかという点についても留意しておき

たい。 

3) Metadata Editor の反応が遅いので、改善が望まれる。 
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23 電子ブックのメタデータ 

(1) 主な検証内容 

1) 既存の電子ブック MARC の作成状況 

(2) 検証時に利用した Alma のメニュー項目 

特になし 

(3) 検証結果 

1) 既存の電子ブック MARC の作成状況 

a) 国立国会図書館（全国書誌） 

 MARC 提供タイトル数：約 2 万 8 千タイトル(2017 年 7 月末時点) 

 フォーマット： DC-NDL（RDF）、DC-NDL（Simple）、JSON 

 対応プロトコル：SRU、SRW、OpenSearch、OpenURL、Z39.50、OAI-

PMH 

 章レベルのメタデータの作成状況、対応フォーマット：各コンテンツの公

開状況に応じて、論文レベル、章レベルでのメタデータを作成 

 セットものの ISBN の取扱：セットものの ISBN があっても通常の ISBN

と区別なく取り扱い 

 LOD、RDF への対応の有無：RDF の対応 

b) 丸善 

 MARC 提供タイトル数：37,771 点(2017 年 5 月末時点) 

 フォーマット： CAT-P 

 対応プロトコル：プロトコルへの対応は未了です。 

 章レベルのメタデータの作成状況、対応フォーマット：現時点では作成し

ていない。 

 セットものの ISBN の取扱：現時点では対応していない。配信タイトル単

位の書誌データの提供のみ。 

 LOD、RDF への対応の有無：未対応 

c) 中国、韓国の MARC 

含まれていない。 

(4) 機能評価 

評価：評価なし 

 



 別紙  

53 

 

24 IZ/NZ/CZ でのデータ管理と共有 

IZ/NZ/CZ でのデータ管理 

(1) 主な検証内容 

1) IZ/NZ/CZ でのデータ管理 

(2) 検証時に利用した Alma のメニュー項目 

1) Resource Management > Resource Configuration > Configuration Menu > 

Record Import > Import Profiles 

2) ResourceManagement>Cataloging>Search External Resources 

3) Resource Management > Resource Configuration > Configuration Menu > 

Record Export > Publishing Profiles 

(3) 検証結果 

1) 新規作成、またはインポートされたレコードについて、IZ または NZ に保存する

機能をオプションとして持っており、デフォルト設定を IZ とするか NZ とするか

を選択することが可能である。 

2) NZ からメタデータの作成・修正・削除が可能で、NZ レコードの更新レベルを制

御することが可能である。 

3) デフォルトでは、MD Editor を使用して手動で NZ のデータに追加を行うと警告

メッセージが表示される。プロファイルを設定することで、追加自体を禁止し、警

告メッセージではなくエラーメッセージを表示するように設定することも可能で

ある。 

4) IZ の書誌レコードを NZ に提供する前に、NZ の検証ルールに基づいてレコードの

変更を検証することが可能である。 

5) NZ からすべてのコンソーシアムメンバー機関のレコードを、Primo へ直接公開す

ることが可能である。この機能を使使うことで、NZ 内の各機関が個別に公開した

場合に Primo でレコードの重複が発生するような事態を防ぐことができる。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) NZ におけるメタデータの共有は、NZ へのアクセス権限があれば、holding がな

い機関や IZ に共有していない機関も編集可能なので、制限がある方がよい。 

(6) 導入時の留意点 

1) 日本においてどのようなデータを CZ・NZ 上に展開して管理するのか整理してお
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く必要がある。 

2) CZ/NZ の管理や Ex Libris 社との調整窓口（機関）が必要である。 

 

IZ/NZ/CZ 間のデータ共有 

(1) 主な検証内容 

1) コンソーシアム内でのデータ共有方法 

(2) 検証時に利用した Alma のメニュー項目 

1) Admin > User Management > Manage Users 

2) Resources > Cataloging > Open Metadata Editor 

(3) 検証結果 

1) 共有方法 

MD Editor には、Link/Copy/Share の３つの機能が存在する。 

a) Link：CZ から IZ に対して各 Item のメタデータをリンクさせる。詳細画面よ

り Link アイコンが表示される。データは編集・削除不可。Link の解除方法は、

MD Editor>File > Copy to Catalog。IZ データは CZ と同期しているため更

新不要。 

b) Copy：CZ から IZ、または NZ から IZ に対してメタデータをコピーする。詳

細画面より Copy アイコンが表示される。コピーとコピー元は別データとし

て扱われるため、それぞれ編集・削除可。データは同期しないため手動で更新

する必要あり。 

c) Share：IZ のメタデータを NZ に共有させる。MD Editor>File > Share with 

network。データ編集・削除可。Share の解除方法は、MD Editor>File > Copy 

to Catalog。編集内容は IZ と NZ の双方に反映されるため更新不要。IZ の書

誌レコードを NZ に提供する前に、NZ の検証ルールに基づいてレコードの変

更を検証することが可能である。 

2) 手順 

Catalog Administrator、Catalog Manager、Cataloger のいずれかの role をユ

ーザーに与えることで、MD Editor での編集・共有のための機能を利用できる。こ

れらの権限をもつと、形態や所蔵・アクセス権限の有無を問わず、NZ に存在する

すべてのメタデータが編集可能になる。Cataloging Permission Levels を設定す

ることで、運用上、人的編集ミスを防ぐことは可能である。 

IZ/NZ/CZ それぞれから他の２つの Zone に対する Link/Copy/Share の可否と可
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能場合のメニューは以下のとおりである。 

a) IZ から 

  NZ CZ 

Copy  MD Editor>File > Copy to Catalog 否 

Share  MD Editor>File > Share with network 否 

編集 NZ のみ可 否 

解除 Resources > Cataloging > Open Metadata Editor > 

copy to catalog 

否 

一括 

処理 

Admin > Manage Jobs and Sets > Run a Job > Link 

a set of records to the Network Zone 

否 

Link  否 否 

 

b) NZ から 

  IZ CZ 

Copy  MD Editor > File > Copy to Catalog 否 

一括 

複製 

否 否 

一括 

削除 

Admin > Manage Jobs and Sets > Run a Job > 

Delete Bibliographic records 

否 

Link  Resources > Cataloging > Open Metadata Editor 否 

編集 NZ のみ可 否 

解除 Resources > Cataloging > Open Metadata Editor > 

Copy to catalog 

否 

一括 否 否 

一括 

解除 

Admin > Manage Jobs and Sets > Run a Job > 

Unlink a set of records from the Network 

否 

 

c) CZ から 

  IZ NZ 

Copy  MD Editor > File > Copy to 

Catalog 

MD Editor>Copy to network 
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一括 否 否 

Link  Resources > Cataloging > 

Open Metadata Editor 

否 

解除 MD Editor > File > Copy to 

Catalog 

否 

編集 否 否 

一括 否 否 

 

3) CZ での書誌共同作成・共有機能 

a) IZ の書誌データは他の図書館でも使用できるように、CZ に登録した後、共有

することが可能である。 

b) CZ の書誌レコードは同一コミュニティ（＝全 Alma ユーザー）内での共有が

可能となっており、IZ の所蔵データを CZ 内の書誌レコードにリンクするこ

とも可能である。この場合、CZ の書誌レコードを IZ にダウンロードする必

要がない。 

c) 書誌レコードを CZ から IZ のカタログにコピーする機能はサポートされてい

るが、Alma の機能上必須ではない。 

(4) 機能評価 

評価：B 

 



 別紙  

57 

 

25 API 経由での利用 

(1) 主な検証内容 

1) Primo/Summon での利用 

2) Alma 以外の既存の ILS への配信 

3) ProQuest 社、Ex Libris 社以外の KB/DS への配信 

(2) 検証時に利用した Alma のメニュー項目 

1) Resources > Publishing > Publishing Profiles 

2) Configuration > General > External Systems > Integration Profiles 

(3) 検証結果 

1) Primo/Summon での利用 

a) Primo：Alma 内で管理するメタデータを Primo へ配信する機能として API で

はなく Publish 機能が用意されている。 

 Publishing to Primo 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Integrations_with_External_Syst

ems/030Resource_Management/100Publishing_to_Primo_and_Pri

mo_Central 

この機能を使うためにはユーザーの role に、Catalog Administrator、

Repository Administrator、General System Administrator のいずれか

を付与する。 

b) Summon：配信するための API は用意されていない。Summon へのデータ

配信は Alma の配信機能を使って Summon と連携することができる。 

 Alma-Summon Integration 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Alma-Summon_Integration 

この機能を使うためにはユーザーの role に、Catalog Administrator、

Repository Administrator、General System Administrator のいずれか

を付与する 

2) Alma 以外の既存の ILS への配信 

管理しているメタデータの Publishing Profile を設定/新規作成する機能を備えて

いる。 

a) Publishing and Inventory Enrichment (General Publishing) 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/100Publishing_to_Primo_and_Primo_Central
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/100Publishing_to_Primo_and_Primo_Central
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/100Publishing_to_Primo_and_Primo_Central
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/100Publishing_to_Primo_and_Primo_Central
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Summon_Integration
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Summon_Integration
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https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Integrations_with_External_Systems/030

Resource_Management/080Publishing_and_Inventory_Enrichment 

b) Output formatはMARC21 とDublinCoreのみ、Publishing ProtocolはFTP、

OAI、Z39.50（MARC21）の３種類である。 

3) ProQuest 社、Ex Libris 社以外の KB・DS への配信 

PubMed、OCLC、COPAC、SBN Italian Union Catalogue などに Publish するこ

とが可能である。 

a) Exporting Metadata 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Integrations_with_External_Systems/030

Resource_Management/020Exporting_Metadata 

(4) 機能評価 

評価：B 

(6) 導入時の留意点 

1) 実際にコンソーシアムで導入して利用することを想定すると、国内の主要 ILS

（NEC、富士通、リコー、NTT データ九州等）との連携実証が必要と思われる。 

 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/080Publishing_and_Inventory_Enrichment
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/080Publishing_and_Inventory_Enrichment
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/080Publishing_and_Inventory_Enrichment
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/020Exporting_Metadata
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/020Exporting_Metadata
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/030Resource_Management/020Exporting_Metadata
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≪システム全般≫ 
(カ) 環境設定 / システムアップデート 

 

概要 

 

【コード管理】 

予算は、ファンド（Funds）や台帳（Ledgers）を設定して管理を行うことが可能。Summary 

Funds の設定による階層管理も行える。通貨、契約相手先、所在等のコード情報も、必要な

項目を設定することが可能であった。 

 

【アカウント管理】 

Alma で取り扱う”User”（スタッフ、利用者、業者）については、各アカウントに対して

役割付与や権限コントロールができる。多様な職位や所属別に、細かい権限設定が必要な機

関でも、ほぼ問題ないレベルとの印象を持った。 

また、利用者の削除について、Purge User Record のメニューからスケジュール化して自

動的に行うことも可能であり、自動化による業務軽減が期待できる。 

利用者区分に応じたサービス内容は、一つの Unit に対して Location と Rule を設定し決め

てゆく。ひと通りの機能は備えており、コンソ内での ILL 機能や貸出し中資料の自動延長機

能などは優れていると言ってよい。日本国内での利用を想定した場合、登録項目に姓名の読

みのフィールドがないことは不便であるため、将来的には NACSIS-ILL システムとの連携

といった対応が望まれる。 

 

【システムアップデート】 

Alma では、開発ロードマップに基づき、毎月全ユーザー共通のアップデート（50-70 項

目程度）が適用される。リリースの詳細は、Release Notes ページで公開されている。リリ

ースによる障害発生が見られたが、１～２時間（最長 4 時間強）で解消されている。 

 

総合評価 

 

B 
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26 コード管理 

予算・支払管理 

(1) 主な検証内容 

1) 図書・雑誌・電子・ILL 等各種別での予算設定可否 

2) 図書・雑誌・電子・ILL 等の種別を問わず同一の予算コードでの運用可否 

3) 図書・雑誌・電子・ILL といった種別を超えた統合的な予算管理の可否 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Acquisitions Infrastructure > Funds and Ledgers 

2) 会計年度：Acquisitions > Acquisitions Configuration > Configuration Menu > 

General > Fund and Ledger Fiscal Period 

3) ファンドの移動：Acquisitions > Acquisitions Infrastructure > Transfer Funds 

/ Move Funds in Hierarchy 

4) ファンドの種別：Acquisitions > Acquisitions Configuration > Configuration 

Menu > Fund Types 

(3) 検証結果 

1) 図書・雑誌・電子・ILL 等各種別での予算設定可否 

可能。allocated fund を該当する種別ごとに作成することができる。 

2) 図書・雑誌・電子・ILL 等の種別を問わず同一の予算コードでの運用可否 

可能。summary fund で"print materials"、"Electronic resources"など任意の単

位で階層関係を作り、下位に allocated fund を紐付けることができる。 

3) 図書・雑誌・電子・ILL といった種別を超えた統合的な予算管理の可否 

可能。「図書館予算」として Ledgers の単位で運用する、あるいは「受入」等の業

務別に summary funds の単位を作成し、下位に allocated fund を紐付けること

ができる。Funds and Ledgers では、fund（ファンド）と ledgers（台帳）の情

報を管理できる。 

 

ledgers と fund の階層関係は以下のとおり。 

Ledgers（台帳） 

- Summary fund（ファンド小計） 

- - Allocated fund（割当分のファンド） 

- Allocated fund 

Summary fund の作成は任意である。階層関係は”Path”項目に表示され、下位の
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summary fund、allocated fund については”funds”のタブから一覧できる。 

 

例： 

Ledgers : Acquisitions Budget（受入予算） 

 - Summary fund : Electronic Resources（>電子リソース） 

 - - Allocated fund 1 : Electronic Journals（>>電子ジャーナル） 

 - - Allocated fund 2 : Electronic Books（>>電子ブック） 

 

allocated fund は"funds"の代わりに"transaction"のタブがあり、各 balance の動き

（貸借）を POL の単位で確認できる。 

 

Ledgers・summary fund・ allocated fund はそれぞれ名前・コード・ステータス・

description といった詳細情報のほか、残高の管理（グラフ表示）が可能である。 

その他、Fund 情報に”External ID”を入力しておくことで、外部のシステムとの連携が

できる。 

https://developers.exlibrisgroup.com/alma/integrations/finance 

https://developers.exlibrisgroup.com/alma/integrations/finance/fund 

(4) 機能評価 

評価：A 

 

通貨管理 

(1) 主な検証内容 

1) 設定可能な通貨の種類・設定内容 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Acquisitions Configuration > Configuration Menu > General 

> Currency Subset 

(3) 検証結果 

1) 設定可能な項目は以下のとおり。 

a) Currency Name（通貨名） 

b) Default（初期値） 

c) Updated by（作業者） 

d) Last Updated（作業日） 

https://developers.exlibrisgroup.com/alma/integrations/finance
https://developers.exlibrisgroup.com/alma/integrations/finance/fund
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2) 通貨は 100 種類以上から選択できる。実際の業務画面に表示する通貨を複数選択

できるようになっており、初期値として表示される通貨を設定する。なお、管理画

面上では表示させておき、業務画面では表示させないような運用も可能である。 

(4) 機能評価 

評価：B 

 

契約相手先・業者情報管理 

(1) 主な検証内容 

1) 図書・雑誌・電子・製本等の種別毎の契約相手先の設定（異なる連絡先や割引率な

どの設定）可否 

2) 業者コードの設定・管理（担当者の名前/担当者の連絡先/振込先/連絡先住所）可

否 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Acquisitions Infrastructure > Vendors 

(3) 検証結果 

1) 図書・雑誌・電子・製本等の種別毎の契約相手先の設定（異なる連絡先や割引率な

どの設定）可否 

Vendor は、”Add Vendor”から追加が可能で、以下の種類を選択できる（複数選

択可能）。 

a) Material Supplier/Subscription Agent（出版社 / 契約代行業者） 

b) Access Provider（アクセス提供者） 

c) Licensor（ライセンス提供者） 

d) Governmental（政府機関） 

種類を 1 つ以上選択し、ベンダー名及びコードを入力することで登録できる。 

ベンダー名とコードについては全ベンダーで共通。入力ルールは特にないが、制約

条件はある（記述できる文字はアルファベットと数字のみ、255 字まで）。 

ベンダー名が同一であっても、コードが異なればベンダーを複数作成することが

可能。各々のベンダーで異なる連絡先の登録や割引率の設定ができる。また、コー

ドが異なっていれば、NZ でローカルなベンダーの情報を共有することも可能。 

2) 業者コードの設定・管理（担当者の名前/担当者の連絡先/振込先/連絡先住所）可

否 

Acquisitions > Acquisitions Infrastructure > Vendors から追加・変更・修正が
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可能である。 

(4) 機能評価 

評価：A 

 

所在管理 

(1) 主な検証内容 

1) 所在コードの設定 

(2) 検証時に利用した Alma のメニュー項目 

1) Top > Fulfillment Configuration > Configuration Menu 

2) Locations - Physical Locations 

(3) 検証結果 

1) 所在コードの設定方法は以下のとおり。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma

_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/030Config

uring_Physical_Locations 

2) library 単位で複数作成することが可能である。所在コード名及びコード番号のほ

か、種別（Open, Closed, Remote Storage, Unavailable）を設定することがで

きる。所在コード種別は 4 種類で固定されており、独自の種別作成はできない。 

3) 貸出・返却カウンターを紐付けることができる。併せて、カウンターで提供できる

サービス（Check in・Check out・Reshelve）を記載することが可能である。 

4) 所蔵の詳細設定では、当該所在コードに蔵書を紐付ける際に必要な MARC コード

（バーコード No、請求記号、配架場所等）を義務化できる。 

(4) 機能評価 

評価：B 

 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/030Configuring_Physical_Locations
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/030Configuring_Physical_Locations
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/030Configuring_Physical_Locations
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27 アカウント管理（図書館スタッフ） 

図書館スタッフのアカウント登録・データ修正方法 

(1) 主な検証内容 

1) 操作可能なワークフロー・メニュー・キャンパス・部局・予算・所在の設定可否 

2) 登録可能なメタデータ 

3) ID・パスワード等の設定変更手順 

(2) 検証時に利用した Alma のメニュー項目 

1) Administration > User Management > Find and Manage Users 

(3) 検証結果 

1) Alma ではスタッフ（Staff）も利用者（Public)も業者（Contact)も同じ枠組みで

管理する。これを"Record type"と呼んでいる。 

2) Internal Users（Alma 内で作ったユーザ）と External users（大学の学生/教員

管理システムなどからデータを Alma にロードして作るユーザー）に大別される。

これを”Account type”と呼んでいる。 

3) 大まかなデータ構造 

General User Information(氏名等）+ User Roles 

a) Identifiers (+Additional identifiers) 

b) Addresses, Phone numbers, Email Addresses 

c) Notes 

d) Blocks 

e) Statistics 

f) Password 

ログインに使用するパスワード。８文字以上で大文字小文字数字を含む必要

あり。 

g) User Roles 

目録担当者、発注担当者などの役割を付与できる。一人に対して複数付与でき

る。 

4) Internal User の場合、パスワードは Alma 上で個別に登録する。8 文字以上で大

文字小文字数字を各 1 文字以上含める必要がある。 

5) 組織、館、キャンパスなどのグループ管理 

a) 組織や館の概念（Topology） 

(The Alma Collaborative Network) > Institution > Campus > Library > 
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Location 

b) Library ごとに PO や Fulfillment の Rule を管理できる。詳細は、下マニュア

ル参照（Topology と業務のクロス表がある） 

Alma > Product Documentation  > Alma Online Help (English) > 

Getting Started  > Alma Topologies 

6) Inventory Management groups というやや特殊な設定があり、これは電子資料

にだけ影響するグループである。キャンパスや館をまたいだ契約（理系＋医学系な

ど）をする場合にこれを使用する。 

7) その他、館やグループ分けに関係しそうなフィールド 

a) User Group（User Information 内） 

これは主に Patron ユーザーをグループ化するもの（貸出ルールの適用など） 

b) User Job Categories 

こちらが業務ユーザーをグループ化するもの（財務、貸出デスク担当など） 

c) Scope（User Roles 内） 

業務（財務・蔵書管理）などを Institution ではなく library/Campus レベル

で限定できる。但しすべての Role で Scope が使える訳ではない（下に対応一

覧表あり） 

参照：Home > Alma > Product Documentation > Alma Online Help (English) 

> Administration > Managing User Roles 

(4) 機能評価 

評価：A 

 

スタッフに応じた権限設定 

(1) 主な検証内容 

1) 同じ権限設定のグループの作成及び権限の一括変更・削除可否 

2) アカウント毎の入力初期値、検索条件等の設定・変更可否 

3) アカウント毎の操作履歴の保存可否 

4) 管理者・一般ユーザー 

(2) 検証時に利用した Alma のメニュー項目 

1) Administration > User Management > Find and Manage Users 

2) Administration > User Management Configuration> Configuration Menu 

(3) 検証結果 
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1) 同じ権限設定のグループの作成及び権限の一括変更・削除可否 

可能である。”Role Profile”を作ることにより権限をグループ化し、一括で設定で

きる。”Role Profile”から特定の権限（Role）を抜いた場合、すでにその Role が設

定されているユーザーにはその権限はついたままになる。Role を一旦全削除し、

改めて Role Profile を設定すれば、新たな（特定の権限が抜かれた状態）Role が

設定される。 

2) アカウント毎の入力初期値、検索条件等の設定・変更可否 

3) アカウント毎の操作履歴の保存可否 

業務ユーザーを作る画面では、テンプレートやデフォルト値の設定のようなもの

は見当たらなかったが、ファンクション毎で異なる可能性がある。テンプレートの

ようなものはアカウント毎ではなくシステム全体で使用できる見込みである。

（例：権限設定する際の Role の profile 等）。 

4) 管理者・一般ユーザーの管理 

大きく、Administrator・Manager・Operator の 3 種類で各業務（目録、閲覧等）

に対して権限設定が可能である。業務によっては更に、Cataloger Extended など

のバリエーションがある。 

 

(4) 機能評価 

評価：B 

 

図書館スタッフ間における情報共有機能の有無 

(1) 主な検証内容 

1) 契約情報の共有可否 

2) 所蔵状態の共有可否 

3) サービス状態の共有可否 

(2) 検証時に利用した Alma のメニュー項目 

1) Administration > User Management > Find and Manage Users 

(3) 検証結果 

1) 個別に契約したものは、各 IZ に発注や契約などの情報が保存され、共有はされな

い。共同購入の場合などは NZ に持つこともできる。Vendor と Fund（予算）を

NZ で管理できる。 

2) 所蔵やサービス（貸出等の意味として）は各 IZ で個別に管理するが、スタッフユ
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ーザーの ID を Switch する等の運用によるカバーも可能である。 

3) 所蔵については有無のみが Alma では共有される。Primo では資料の状況（貸出

中か否か）が確認できる。 

4) サービス状態（貸出状況）については、ユーザーは異なる機関で借りた資料につい

ても自機関で借りた資料とまとめて状況の確認が Primo から可能である。 

(4) 機能評価 

評価：A 
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28 アカウント管理（一般利用者） 

一般利用者のアカウント登録・修正方法 

(1) 主な検証内容 

1) 登録可能なメタデータ 

2) ID・パスワード等の設定変更手順 

3) 登録する個人情報項目の要否 

4) 利用者登録・削除手順の確立 

(2) 検証時に利用した Alma のメニュー項目 

1) Administration > User Management > Find and Manage Users 

(3) 検証結果 

1) 前提となるユーザーの考え方は「図書館スタッフ（業務利用者）の管理・運用」と

同様である。 

2) 登録可能なメタデータ 

a) 大まかなデータ構造 

General Information（以下、User Information(氏名等）、User Management 

Information（パスワード）、User Roles（目録担当者、一般利用者などの役

割）)が基本部分となる。ここに以下の要素が紐づく。 

 Identifiers (利用者識別用のバーコード、Google・Facebook などの SNS

の ID など) 

 Addresses, Phone numbers, Email Addresses 

 Notes（ユーザーへの表示/非表示が選択可能） 

 Blocks 

 Statistics 

 Attachments 

 Proxy for 

 Audit 

b) メタデータの一覧 

 First name: （必須）下の名前 

 Middle name: ミドルネーム 

 Last name: （必須）苗字 

 Primary identifier: （必須）メインの ID。組織内でユニークでなければ

ならない。 
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 Title: Mr.などの敬称 

 PIN number: 自動貸出機を使う際に必要とされる 4 桁の暗証番号。 

 Job category: 目録担当者、貸出カウンター担当者などの職種。職種に対

して予め役割（Role）を割り当てておくことができる。 

 Job description: 職種に関する自由記述式のフィールド 

 Gender: 性別。male, female, none, other から選択可能。 

 User group: 学生、卒業生、スタッフなどのグループ 

 Campus: （属する）キャンパス 

 Website URL: ユーザーの Web サイトアドレス。 

 Preferred language: ユーザー宛のメールでの使用言語。予め言語を設

定しておく必要がある。 

 Status: Active か inactive 

 Status date: Status の最終更新日 

 Birth date: 誕生日 

 Expiration date: そのユーザーが組織を離れるとされる日 

 Purge date: データの停止日（データ自体は残すが機能を失った日）。 

 Resource sharing library: ユーザーが Resource sharing の希望を出し

た際に担当する館。５つまで設定できる。 

 Cataloger level: カタロガーレベル 

 (Select Patron Letters): 利用者向け通知の出す/出さないを選択できる

（Activity report, Courtesy letter, Loan status letter, Overdue notice, 

Recall cancellation letter, Recall letter) 

 Send message: 利用者向けにその場で Email を送信することができる。

email 以外に”social login mail”が設定でき、これは SNS を使った通知

か？ 

 Created By: このユーザデータが作られた日 

 Updated By: このユーザデータが最後に更新された日 

3) ID・パスワード等の設定変更手順 

ID はプライマリーは「User information」にて、その他は「Identifiers」にて設定す

る。「User management information」のブロックでパスワードを設定する。 

4) 登録する個人情報項目の要否 

必須となる項目は First name, Last name, Primary identifier の３つ。性別や誕生日
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などは必須ではない。 

5) 利用者登録・削除手順の確立 

登録は、Internal User（システム上で作成）と External User（外部システムからの

データをロードして作成・更新する）に分かれる。削除は１件ずつも行えるが、「Purge 

User Record」のメニューにて、スケジュール化して自動的に行うことも可能である。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) 日本で導入する場合、氏名ヨミのフィールドがあることが望ましい。 

2) 現在「姓名」が 1 つのフィールドで管理されている ILS が存在していることを鑑

みると、姓・名が別フィールドになると移行が困難である（両方必須項目となって

いる）。 

 

利用者区分に応じたサービス内容の設定方法 

(1) 主な検証内容 

1) 設定可能な項目の精査（ILL、貸出条件など） 

(2) 検証時に利用した Alma のメニュー項目 

各検証結果内に示す 

(3) 検証結果 

1) 貸出の条件 

a) Fulfillment Unit 

Alma では"Fulfillment Unit"という単位があり、組織（大学）もしくは館単位

で設定ができる。組織単位であれば、そこに含まれる館の Location を自由に

登録できる。図 書館単位とすると、その間の Location しか登録できない。但

し１つの Unit には最大 1,000 個の Location と決まっている。この Unit に

対して、出納依頼の可否（他館、他キャンパスに限定等）、予約の可否、未貸

出状態の資料への予約の可否などが設定できる。この Unit に対して、

Locations と Rule を設定する。 

b) Fulfillment Policy 

いわゆる貸出規則を含む様々なサービスに対するルール設定で、Booking、

Borrowing Resource Sharing、Lending Resource Sharing、Loan、Request、

User Registration がある。 
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c) Terms of Use (a list of policies) 

Fulfillment Policy で使用するルールそのものである。 

d) Item Policy 

Fulfillment Unit に設定された Rule の例外として、特定の Location の特定の

Item に対して設定できるルールで、館単位ではなく組織単位でのみ設定する

ことが推奨されている。 

e) Automatic Loan Renewal Rules 

Courtesy Notices（期限日前のお知らせ）と連動して、自動延長の機能があ

り、設定された条件を満たすと自動的に延長される。 

2) ネットワーク内のユーザーへのサービス 

Alma では Fulfillment Network に属する Institution に所属する Patron をウォ

ークインユーザーとして、自館に登録（コピー）することができる。 

3) 利用者による各種リクエスト 

Alma ではスタッフもしくは利用者によるリクエストをまとめてリクエストと呼

んでいる。ここでは利用者によるリクエストについて述べる。 

a) Booking request： 貸出できない資料などを特定の時間、占有するために予

約できる機能 

b) Patron digitization request / Patron Electronic Digitization Request： 物

理的もしくは電子的な資料から電子的なコピーを作ってもらうためのリクエ

スト 

c) Patron physical item request：物理的な資料を借り出すための取り置きリク

エスト 

d) General hold request：書誌と Holding はあるが、Item が無い場合の予約 

4) ILL （Resource Sharing） 

Alma では Resource Sharing には大きく２つのタイプがある。１つは Peer-to-

peer（参加組織・館内での貸借）、もう１つは Broker-based（業者・外部システ

ム経由）である。 

a) Broker-based 

Open URL に対応した外部システム（Broker）へ利用者からの ILL 要求を投

げることが可能。 

b) Peer-to-peer 

Institution 内（学内の ILL）もしくは Network zone 内（コンソ内での ILL）
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が可能。リクエストは Primo などから利用者自身が起こすか、カウンター等

でスタッフが Alma の管理画面から起こす方法がある。API 経由でリクエスト

を受け取ることも可能。「Rota」と呼ばれる依頼する館群の優先順位付きリス

トを予め設定しておくことができる（例：A 館に断られたら B 館に依頼を転

送する）。Alma 利用館同士であれば、予め設定しておくことにより、ILL 貸

出の可否を自動判別してくれる（Item の現況や、ILL 対象資料か否か）。 

(4) 機能評価 

評価：A 

 



 別紙  

73 

 

29 システムアップデート 

(1) 主な検証内容 

1) システムアップデートの頻度・内容 

2) アップデートによる障害の有無 

(2) 検証時に利用した Alma のメニュー項目 

1) Release Notes 

https://knowledge.exlibrisgroup.com/Alma/Release_Notes 

2) Ex Libris System Status 

http://status.exlibrisgroup.com/ 

3) Have an idea for Ex Libris? 

http://ideas.exlibrisgroup.com/ 

(3) 検証結果 

1) システムアップデートの頻度・内容 

a) 毎月、定期的に修正アップデートが行われている。 

b) Release Resolved Issues と HF Release Resolved Issues（HF=hotfix, 、

迅速な提供を最優先とする修正プログラム）が一覧で公開されている。 

c) Resolved Issues は毎月、50-70 項目が、機能（Acquisitions、Administration、

Analytics、Fulfillment 等）別にまとめられている。HF Release Resolved 

Issues は 10 項目が、機能別にまとめられている。 

d) 個々に寄せられた要望・質問のうち、共有すべき内容は、Knowledge Center

へ編集されて組み込まれる。 

e) 改善のアイディアは、投票制になっており、上位のものが採用される。 

2) アップデートによる障害の有無 

a) Alma AP01 の E メールアラート（2017/4/7~2017/10/26）を集計した結

果、メンテナンス以外のサービス停止は、８件あった。１～２時間（最長 4 時

間強）で解消されている。 

(4) 機能評価 

評価：B 

https://knowledge.exlibrisgroup.com/Alma/Release_Notes
http://status.exlibrisgroup.com/
http://ideas.exlibrisgroup.com/
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≪参考： 冊子体業務≫ 
(キ) 冊子体の管理・閲覧業務 
 

概要 

 

Alma の特徴である冊子体と電子のワークフローの共通化は、情報メディアの変化に直面

する図書館にとって、その業務の効率化を図る上で大きな意味を持つ。それゆえ本課題にお

いては、伝統的な冊子体のワークフローを踏まえた上で、電子特有のワークフローの理解が

進むよう、いわば補完的な形で冊子体に関わる機能の検証を中心に進めて行くこととした。

なお、現状、電子に関しては国内においてそれを扱う上でのモデル的なワークフローが存在

しないことから、Alma におけるモデル的な業務の流れを明らかにすることは一定の意義が

あると考えたことも、本検証を行うに至った理由である。 

 冊子体に関する選書から管理に至るようなテクニカルサービスの流れは、図書、雑誌とも

に基本を十分に抑えており、非常に合理的に設計されていると判断することができた。ただ

し、国内においては、取引先の代理店や出版社とのやり取りの手段として、欧米では一般的

な EDI や EOD といった電子的な方式が利用できる状態には至っておらず、Alma の機能の

一部が十分に活用しえないことは認識しておく必要があるだろう。 

ところで現行の国内の図書館において、ルーチンワークのひとつとして、広く行われてい

る業務に督促がある。したがって Alma における督促の扱い方を理解することは、国内への

適用可能性を考える上で重要な要素となりうるだろう。実際 Alma においては「電子」をさ

まざまな角度から柔軟に扱える環境が整えられていることを鑑みれば、冊子体における督

促のあり方を検証するのみならず、例えば電子ブックの貸出や STL などに対して、期限切

れを事前に通知する仕組みを有しているのか否かなど、「電子」に特化した督促に類する機

能が網羅する範囲を認識しておくことも必要である。 

結論を言えば、冊子体の督促そのものについては、メールや手紙、電話などのさまざまな

方法を実施できる環境が準備されていたほか、貸出期限の事前通知をメールで送付する機

能を有していた。一方、「電子」の STL や貸出に関する通知機能は有していなかった。とは

いえ、これは「電子」のコンテンツの管理主体が、Alma ではなく、出版社やアグリゲータ

のウェブサイトにあることを考えれば、むしろ当然とも言うべき状況であり、実際の運用に

際しての問題点とはなりえないと考えられる。 
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総合評価 

 

B
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30 資料種別を超えた統合的管理 

(1) 主な検証内容 

1) 資料種別を超えたリンク形成可否 

(2) 検証時に利用した Alma のメニュー項目 

1) Resources>Cataloging>Open Metadata Editor 

(3) 検証結果 

1) Alma 内で FRBR の表現形あるいは著作レベルでの集約機能はない。 

2) 資料種別を超えたリンク形成機能について検証したが、Alma から外部へのサービ

ス連携は行われていなかった。 

a) XISBN の利用：サービス連携なし 

b) ISSN-L：MARC21 では 022 に記述する。Alma では ISSN の記入欄は２箇所

あるが、たとえ同じ ISSN-L をもつ２つの資料であっても、P-ISSN もしくは

eISSN を検索キーにしたときにもう片方をヒットさせることはできない。 

(4) 機能評価 

評価：評価なし 
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31 冊子体の受入・目録業務 

図書 

(1) 主な検証内容 

1) 選書・発注・検収手順 

2) 国 内 選 書 シ ス テ ム と の 連 携 が 可 能 か （ Knowledge Worker 、 PLATON 、

Amazon.co.jp、CiNii Books、JPO 近刊情報センターなど） 

3) 資産管理 

4) クレーム（督促・請求書等の作成依頼）手順 

5) 目録作成手順 

6) 所蔵登録・装備・配架手順 

(2) 検証時に利用した Alma のメニュー項目 

1) Acquisitions > Purchase Order Lines > Search for PO Line 

2) Acquisitions > Receiving and Invoicing > Receive 

(3) 検証結果 

1) 選書・発注・検収手順 

一連の手順は電子と共通であり、POL ごとに管理される。発注にあたっては書店

（代理店）ごとの PO が作成され、これを用いて行うことになる。なお Invoice を

管理する番号 Invoice Number は、代理店や出版社より提出された請求書に記載

されたものを入力して利用するのが一般的であるとのことだが、デフォルトで PO 

Number が記入されていた。継続発注（スタンディングオーダー）を初め、前払い

後払いといった部分も、問題なく可能である。 

2) 国内選書システムとの連携が可能か 

国内選書ステムとの連携については、たとえば Amazon.co.jp については、検証

環境において API を通じて検索した書誌を利用して POL の作成が可能になる機能

が実装されていた。他の選書システムにおいても、この程度の機能であれば実装で

きる可能性は高く、より深い連携を行いたいという場合には、国内選書システム側

と交渉することで、EOD データあるいは EDI などでの連携を模索する方法もある

と考えられる。 

3) 資産管理 

例えば「資産」と「消耗品」という管理形態をとっている場合であっても、予算コ

ード及び元帳を Funds and Ledgers で各自設定するということで対応可能であ

る。元帳と予算コードは階層になっているので、適宜設定できる。Transfer funds
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など予算流用の設定も可能であり、一般的な日本の図書館で行われている機能は

実装されている。所蔵に対して、不在 missing、除籍 withdraw といったステータ

スの設定も問題なく行える。蔵書点検についても、Book Shelf Report 機能によ

り、実行可能である。 

4) クレーム（督促・請求書等の作成依頼） 

納品予定日に発注した図書が届かないということであれば、書店に自動でメール

が発送されるといった自動での管理機能のほか、POL のコミュニケーションタブ

を利用することで、書店とのメールのやり取りを POL ごとに蓄積していくことが

可能である。電話、あるいは口頭といった場合でも、そこに記入することで継続的

に管理することが可能である。 

5) 目録作成手順 

NZ や CZ からダウンロードした書誌に、MD Editor により手を加えて、IZ 向けの

書誌を作成することが可能となっている。なお書誌のフォーマットは、現時点では

MARC 21 となる。それゆえ、日本の大学図書館では CAT-P フォーマットの利用

が一般的であることを考えると、何らかの対応が行われることが望ましい。 

6) 所蔵登録・装備・配架手順 

a) 所蔵登録 

受入・検収の時点で、Scan In Items において、あらかじめ図書に添付された

「バーコード」の番号を読み取り、それをキーとして書誌と結びつける。 

b) 装備 

受入・検収の段階で、図書に「バーコード」番号が付与されている必要がある

ことから、あらかじめ資料番号シールなどが、図書に添付されていることが望

ましい。現在のところ、資料番号、すなわち「バーコード」番号について、例

えばチェックデジットを付与した形などで Alma が主体的に生成することは

できない。 

c) 配架 

Scan In Items におけるプロセスを経た後、Item が Holding の下で、書誌に

結合することで、初めて可能になる。そのほか、Scan In Items > Change 

Item Information で、Change Type を Temporary とすれば、たとえば新着

の図書のみを「新着図書コーナー」などに一時的に配架するなどといった管理

を簡便に行えるようになる。 

(4) 機能評価 
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評価：B 

(5) 改善への提言 

1) 日本国内において EOD データや EDI の利用が可能になれば、業務における発注フ

ローの軽量化は著しく進む可能性がある。CAT-P フォーマットとの間で、データ

を相互変換するしくみが構築されるべきであると考える。 

 

雑誌 

(1) 主な検証内容 

1) 新規購読・中止時の手順 

2) 支払管理（年間払い・都度払い・定期払い） 

3) 欠号管理 

4) クレーム（問い合わせ・請求書等の作成依頼）手順 

5) セット誌管理 

6) 受入管理（一括受入・個別受入・製本との連携） 

(2) 検証時に利用した Alma のメニュー項目 

1) （新 UI トップページ）>Repository Search 

2) Resources>Cataloging>Open Metadata Editor 

(3) 検証結果 

1) 新規購読・中止時の手順 

a) 新規購読 

Repository Searchから、CZあるいはNZの書誌を検索することから始まる。

電子もしくは冊子体の書誌があれば、それを用いて Purchase type を Print 

Journal – Subscription とすることで、POL を作ることができる。その後は

図書と同様の発注ルートになる。PO を作成するのに、Auto Packaging を待

っても良いが、Order Now ということで、即時発注も可能である。 

b) 中止時 

継続状態（Waiting for renewal）というステータスにある POL に対して、

Close のコマンドを選択するだけでよい。すなわち、Search for PO Line で

中止したいタイトルを検索し、前述の作業を行えば、購読を中止できる。 

2) 支払管理（年間払い、都度払い、定期払い） 

各支払方法に柔軟に対応できる。いずれも Invoice の Payment Method から派生

する形で設定できる。ただし Payment Method にて、Accounting Department
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を選ぶと通常の後払いしか出来なくなるので、留意が必要である。 

3) 欠号管理 

あらかじめ prediction patterns を書誌に設定することで、欠号の把握が可能であ

る（MARC standard 853 field 852field を利用）。欠号管理をしたい書誌に対し

て、MD Editor の edit から、Expand from Template を選び、Serials prediction

を適用することで、簡単に入力できる。入力後、予定の日付までに届かないものに

ついては UnRecieve というフラグがたつことで、欠号を把握できるようになる。 

4) クレーム（問い合わせ・請求書等の作成依頼）手順 

クレームに関しては図書の場合と同様である。 

5) セット誌管理 

数タイトルがセットとなり、バンドルされた形で発注される雑誌の管理について

は、特段、注目すべき機能はないようである。予算については POL レベルでの管

理が可能である。 

6) 受入管理（一括受入・個別受入・製本との連携） 

一括受入・個別受入とも可能である。製本に関しても、holdings の Actions から 

Bind items という機能を使うことで、対応できる。 

(4) 機能評価 

評価：B 

 

年度更新 

(1) 主な検証内容 

1) 継続時の手順（仮発注・前金払い・後金払いまでの流れ） 

2) 精算・戻入手順 

3) 見積もり合わせの手順 

(2) 検証時に利用した Alma のメニュー項目 

1) Resources > Cataloging > Open Metadata Editor 

(3) 検証結果 

1) 継続時の手順（仮発注・前金払い・後金払いまでの流れ） 

a) 図書の場合、初回の発注時に MD Editor で「継続」を前提とした発注用書誌

を作成する必要がある。Tools の Set management Tags から Suppressed

を選ぶと非表示の書誌として扱うことができる。その後、この書誌を元に POL

を作成し、Purchase Type を Print Book – Standing Order とすることで、
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継続発注という形になる。 

b) 仮発注に関する特段の機能はないが、POL のコミュニケーションタブなどで

発注に至るまでの内容を記録し、その後正式発注を行うことは可能である。 

c) 継続の対象となっている図書が届いた場合、Resource Management の

Create Inventory から、Add Physical Item を行い、Holding の下に位置す

る Item を作成。そこに受入の日付などの Receiving Data と POL を記録す

ることで、受入処理を行う。 

d) 継続の支払いは Item ごとの Invoice Numberで管理。継続用の POL に対し、

異なる Invoice Number の請求書を紐付けていくことで、前金払い・後金払

いといった支払いを行う。 

e) 継続の POL については、継続停止の決定がなされた時点で、マニュアルによ

りクローズする必要がある。 

2) 精算・戻入手順 

a) 返却された金額分について、該当の予算額の修正を行うといった修正は可能

だが、精算(戻入)対象の金額や処理状態を巻号単位で管理することは難しい。 

3) 見積もり合わせの手順 

a) 特化した機能はないが、仮発注と同様に、発注前の各社見積もりの内容につい

て、段階的に POL のコミュニケーションタブなどで記録することは可能であ

る。ただし POL は Material supplier の選択を行わないと作成できないので、

発注の決まった社をセットする、などの工夫が必要である。発注が決まらない

段階で発注されないように Auto Packaging ではなく、Manual packaging を

選択することが必要である。 

(4) 機能評価 

評価：B 

 

所在管理 

(1) 主な検証内容 

1) 所在情報の管理 

2) 部局図書室・研究室貸出管理 

3) 蔵書点検 

4) 除籍・在籍管理 

(2) 検証時に利用した Alma のメニュー項目 
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1) 所在情報の管理 

Fulfillment > Fulfillment Configuration > Configuration Menu > Locations > 

Physical Locations 

2) 部局図書室・研究室貸出管理 

Fulfillment > Fulfillment Configuration > Configuration Menu > Physical 

Fulfillment > Fulfillment Units 

3) 蔵書点検 

Resources>Manage Inventory>Shelf Report 

4) 除籍・在籍管理 

（新 UI トップページ）>Repository Search 

(3) 検証結果 

1) 所在情報の管理 

所在として設定可能な項目は以下のとおりである。 

 

 

 

 

 

 

 

 

“Location type”はリストから、開架（Open）・閉架（Closed）・Remote Storage

（閉架よりももっと時間がかかる）・利用不可（Unavailable）を選択する。 

“Fulfillment unit”を登録することにより所在毎の利用条件、貸出条件等を設定す

ることができる。 

2) 部局図書室・研究室貸出管理 

physical locations・request policies・terms of use を含む Fulfillment Unit を

作成することにより、通常の貸し出し条件に加えて、部局や研究室といったイレギ

ュラーな貸出条件を設定することができる。（下図は Fulfillment Unit リスト） 
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Fulfillment Unit で設定可能な主な事項は、On Shelf Request Policy（図 1）、

Physical Location Type（図 2）、Loan(ほか Booking、Request。図 3)である。 

 

 

 

 

 

 

 

 

図 1：On Shelf Request Policy 

 

 

 

 

 

 

 

 

 

 

図 2：Physical Location Type 
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図 3：Loan(ほか Booking・Request) 

3) 蔵書点検 

Shelf Report を使って行うことができる。手順は一般的な蔵書点検と同じく、蔵

書点検を行う所在、あるいは請求記号で範囲を指定して、CSV ファイルを読み込

ませることで実行可能である。 

4) 除籍・在籍管理 

各所蔵のステータス（不在 missing・除籍 withdraw）は、Repository Search か

ら該当の所蔵を有する書誌を呼び出し、Items をクリックすることで、設定が可能

である。 

(4) 機能評価 

評価：B 
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32 冊子体の閲覧業務 

貸出および返却 

(1) 主な検証内容 

1) 貸出および返却処理の操作 

2) 個人での貸出処理（セルフ貸出端末）の可否 

(2) 検証時に利用した Alma のメニュー項目 

1) Fulfillment > Checkout/Checkin > Manage Patron Services (貸出及び返却) 

2) Fulfillment > Checkout/Checkin > Retuen Item (返却) 

(3) 検証結果 

1) 貸出および返却処理の操作 

a) Fulfillment > Manage Patron Services から利用者カードのバーコードまた

は ID、氏名等の入力により利用者を特定、Loan(貸出)、Returns(返却)の処

理を行う。利用者特定後は、Loan(貸出)のタブから「Loan Display: All loans」

を選択すると貸出中の資料が表示され、ここから返却期限の変更などを行え

る。 

b) 貸出（返却）は資料現物のバーコードの読み込みまたは Physical items をキ

ーワードなどから検索して実行できる。返却については、Fulfillment > 

Checkout/Checkin > Retuen Item から料現物のバーコードの読み込みま

たは Physical items をキーワードなどから検索して実行できる。 

c) 返却操作後、他館所蔵資料など配送等の必要がある場合はこの旨表示され、配

送などのワークフローに遷移することができる。 

2) セルフ貸出端末 

SIP2 プロトコルに対応した機器と通信して利用可能であることをマニュアルによ

り確認した。実接続と設定は行っていない。 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) 運用に必要な機能をすべて備えていると考える。ただし、セルフ貸出端末について

は、国内で多く利用されている ABC プロトコルには未対応のため注意が必要であ

る。 
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予約 

(1) 主な検証内容 

1) 予約の手順の確立 

2) 予約した情報の変更 

3) 予約した情報の削除 

4) 処理状況の参照 

(2) 検証時に利用した Alma のメニュー項目 

1) Fulfillment 

(3) 検証結果 

1) 予約した情報の変更 

Monitor Requests & Item Processes > 該当のデータ表示 > Edit で Pickup す

る library の変更、cancel で取り消しなどができる。 

2) 予約した情報の削除 

Monitor Requests & Item Processes > 該当のデータ表示 > Edit で Pickup す

る library の変更、cancel で取り消しなどができる。 

3) 処理状況の参照 

 Monitor Requests & Item Processes または patron service で利用者情報か

ら参照できる。 

4) 予約 

a) Primo から Request を行い、他の利用者に貸借中の場合は予約の順に queue 

に加えられる 

b) 貸借中の図書が返却されると、自動的に予約の順に該当利用者の棚にデータ

が置かれる。 

(4) 機能評価 

評価：B 

 

督促 

(1) 主な検証内容 

1) 電子の STL、電子の貸出に関する期限切れ事前通知 

2) 冊子の貸出期限に関する事前通知 

3) メール以外の督促方法の確認 

(2) 検証時に利用した Alma のメニュー項目 
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1) Fulfillment > Fulfillment Configuration > Configuration Menu > General > 

Fulfillment Jobs Configuration 

2) Fulfillment > Fulfillment Configuration > Configuration Menu > Physical 

Fulfillment > Overdue and Lost Loan Profile 

(3) 検証結果 

1) 電子に関して STL ならびに貸出を Alma で管理する仕組みはないようだが、本質

的には電子ブックを提供するサイト側で用意すべきものであり、そこまでの機能

の必要性は薄い。 

2) 事前通知に関しては、Fulfillment Jobs Configuration の Send Courtesy Notices 

and Handle Loan Renewals を Active にすることで、メールにて送付できるよう

になる。 

3) Overdue and Lost Loan Profile では、letter send format として、MAIL・PRINT・

BOTH の選択が可能である。このうち、Mail は email を指し、Print は文書の印刷

（提示）を目的とする。Both は両方を行う場合である。Email アドレスの登録が

ない場合、Mail はエラーになる。OBI で督促対象者を抽出することで、電話番号

リストなどを作ることも可能である。 

(4) 機能評価 

評価：B 

 

ILL/DDS 

(1) 主な検証内容 

1) 利用者からの受付 

2) 他館からの受付 

3) 他館への依頼 

(2) 検証時に利用した Alma のメニュー項目 

1) 利用者からの受付 

a) Fulfillment > Resource Sharing > Lending Requests 

b) Fulfillment > Checkout/Checkin > Manage Patron Services 

2) 他館からの受付 

a) Fulfillment > Resource Sharing > Partners 

b) Fulfillment > Resource Sharing > Lending Requests 

3) 他館への依頼 
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a) Fulfillment > Resource Sharing > Partners 

b) Fulfillment > Resource Sharing > Borrowing Requests 

(3) 検証結果 

1) 利用者からの受付 

a) 処理手順の確立 

 ワークフロー 

以下にワークフローが示されている。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing

/010Resource_Sharing_Workflow 

Alma では Peer-to-Peer Resource Sharing（参加組織・館内での貸借）

と Broker-based Resource Sharing（業者・外部システム経由）の 2 パ

ターンが想定されている。 

 事前設定 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Fulfillment/020Circulation_Desk_

Operations/040Managing_Patron_Services 

利用者（Patron）情報を事前に作成しておく必要がある。 

 作業手順 

詳細な手順については、以下に記述されている。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing

/030Managing_Resource_Sharing_Lending_Requests/Creating_a_

Lending_Request 

b) 電子版の利用可否 

下記ページから利用可否の確認・修正・追加が可能である。 

Configuration Menu > Fulfillment > Digital Fulfillment > Access Rights 

冊子体を電子化した際に、利用条件を以下から確認・修正・追加可能である。 

Configuration Menu > Fulfillment > Digital Fulfillment > Digitization 

Profile Rules 

c) 決済 

利用者画面から"Resource Sharing Receive Fee"・"Resource Sharing 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/010Resource_Sharing_Workflow
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/010Resource_Sharing_Workflow
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/010Resource_Sharing_Workflow
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/020Circulation_Desk_Operations/040Managing_Patron_Services
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/020Circulation_Desk_Operations/040Managing_Patron_Services
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/020Circulation_Desk_Operations/040Managing_Patron_Services
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests/Creating_a_Lending_Request
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests/Creating_a_Lending_Request
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests/Creating_a_Lending_Request
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests/Creating_a_Lending_Request
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Request Fee"・"Document Delivery Service"等を選択して、利用者に金額

を紐づけることが可能である。Circulation Desk が受け付けている支払い方

法に合わせ、複数選択できる。 

d) ユーザーが直接他の図書館（コンソーシアム参加館）に本の貸出リクエストを

行える機能 

e) 所属機関以外の図書館での貸出・返却機能 

検証対象外とした。 

理由：海外のコンソーシアム館に、図書館を通さずシステム連携のみで貸出を

行う館があるとのことで検証項目に挙げられていたものの、2017 年 12 月現

在、日本においてはそのシステム連携を支える外部サービスが存在せず、また

部会内でそういった挙動に対する要望も認められなかったため。 

2) 他館からの受付 

a) 処理手順の確立 

 ワークフロー 

1）利用者からの受付と同様。 

 事前設定 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Integrations_with_External_Syst

ems/040Fulfillment/020Resource_Sharing_Partners 

プロトコルは NCIP・ARTEmail・ISO・Email・SLNP・BLDSS に対応し

ている。 

 作業手順 

依頼作成後、コマンドごとの詳細な手順については、以下に記述されてい

る。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing

/030Managing_Resource_Sharing_Lending_Requests 

以下の 2 パターンで手順が異なる。 

Adding a Resource Sharing Lending Task Manually 

Adding a Resource Sharing Lending Task From a Search 

b) 電子版の ILL での利用などライセンスの確認 

デジタル資料については、以下に詳細な説明がある。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/020Resource_Sharing_Partners
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/020Resource_Sharing_Partners
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/020Resource_Sharing_Partners
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/030Managing_Resource_Sharing_Lending_Requests
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https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/07

0Digital_Fulfillment?uxp=true#Configuring_Digitization_Profile_Rules 

デジタル化した資料のメタデータ（及びスキーマ）、権利情報、使用できる範

囲などを規定できる。 

3) 他館への依頼 

a) 処理手順の確立 

 ワークフロー 

1）利用者からの受付と同様。 

 データ作成 

データ作成には、以下の 3 つの手法がある。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Integrations_with_External_Syst

ems/040Fulfillment/020Resource_Sharing_Partners 

 

Manually Adding a Borrowing Request 

Adding a Resource Sharing Borrowing Task From a Search 

Adding a Request From an External Resource（OCLC、WorldCat 等

のメタデータ） 

 

プロトコルは、NCIP、ARTEmail、ISO、Email、SLNP、BLDSS に対応

している。 

 作業手順 

依頼作成後、コマンドごとの詳細な手順については、以下に記述されてい

る。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentati

on/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing

/020Managing_Resource_Sharing_Borrowing_Requests 

(4) 機能評価 

評価：評価なし（検証環境の制約による） 

(5) 改善への提言 

1) 日本においては NACSIS-ILL システムが一般に普及しているが、2017 年 12 月現

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/070Digital_Fulfillment?uxp=true#Configuring_Digitization_Profile_Rules
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/070Digital_Fulfillment?uxp=true#Configuring_Digitization_Profile_Rules
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/080Configuring_Fulfillment/070Digital_Fulfillment?uxp=true#Configuring_Digitization_Profile_Rules
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/020Resource_Sharing_Partners
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/020Resource_Sharing_Partners
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/020Resource_Sharing_Partners
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/020Managing_Resource_Sharing_Borrowing_Requests
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/020Managing_Resource_Sharing_Borrowing_Requests
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Fulfillment/050Resource_Sharing/020Managing_Resource_Sharing_Borrowing_Requests
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在、Alma は同システムに対応していない。 

NACSIS-CAT/ILL システム対応メーカー一覧 

https://www.nii.ac.jp/CAT-ILL/about/system/maker.html 

もっとも、技術的には現段階で対応が可能である（ISO プロトコル経由）ため、

Alma 導入に当たっては運用元の NII を含めた検討が必要と思われる。 

ILL システム操作マニュアル ISO ILL プロトコル対応 第 3 版 

http://catdoc.nii.ac.jp/pdf/ill_iso3.pdf 

 

https://www.nii.ac.jp/CAT-ILL/about/system/maker.html
http://catdoc.nii.ac.jp/pdf/ill_iso3.pdf
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33 相互運用性の確認 

機関外 

(1) 主な検証内容 

1) 連携可能な書誌ユーティリティ・典拠の種類 

2) 連携可能なメタデータエンリッチサービスの種類 

3) 国際 ILL（ISO-ILL）プロトコルへの対応 

4) 外部提供インターフェースの種類（OAI-PMH など） 

5) 国外ベンダーの EDI 対応状況・国内ベンダーの EDI 対応可能性 

(2) 検証時に利用した Alma のメニュー項目 

1) Resources>Cataloging>Open Metadata Editor 

2) General>External Systems>Integration Profile 

(3) 検証結果 

1) 連携可能な書誌ユーティリティ・典拠の種類 

MD Editor で利用可能なフォーマットを持つデータであれば連携可能である。 

Configuring Cataloging 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma

_Online_Help_(English)/Resource_Management/080Configuring_Resource

_Management/030Configuring_Cataloging 

2) 連携可能なメタデータエンリッチサービスの種類 

Alma は ISSN-L、NDL サーチ API など外部サービスとの連携を利用したワークフ

ローは想定しておらず、Alma 内で完結するように設計されている。 

a) 「BOOK」データベース 

データベースがエンドユーザー向けであることを考えると Primo との連携が

より好ましいため、検証からは外した。 

b) Syndetics Indexed Content Enrichment (ICE) 

図書館 OPAC 向けのメタデータを提供する Syndetics Solutions のサービス。

Primo で利用可能。 

Syndetics 

https://knowledge.exlibrisgroup.com/Primo/Product_Documentation/

Interoperability_Guide/040Linking_to_Delivery_Systems/110Syndetic

s 

3) 国際 ILL（ISO-ILL）プロトコル 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Resource_Management/080Configuring_Resource_Management/030Configuring_Cataloging
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Resource_Management/080Configuring_Resource_Management/030Configuring_Cataloging
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Resource_Management/080Configuring_Resource_Management/030Configuring_Cataloging
https://knowledge.exlibrisgroup.com/Primo/Product_Documentation/Interoperability_Guide/040Linking_to_Delivery_Systems/110Syndetics
https://knowledge.exlibrisgroup.com/Primo/Product_Documentation/Interoperability_Guide/040Linking_to_Delivery_Systems/110Syndetics
https://knowledge.exlibrisgroup.com/Primo/Product_Documentation/Interoperability_Guide/040Linking_to_Delivery_Systems/110Syndetics
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対応している。 

ISO ILL 

https://developers.exlibrisgroup.com/alma/integrations/resource_sharing

/p2p/iso 

4) 外部提供インターフェースの種類（OAI-PMH など） 

対応可能である。 

OAI integration 

https://developers.exlibrisgroup.com/alma/integrations/oai 

5) 国外ベンダーの EDI 対応状況・国内ベンダーの EDI 対応可能性 

国内においては丸善雄松堂株式会社が XML 形式での対応している前例はあるもの

の、国際的は ONIX-PL 準拠が標準であるため、EDI の対応には課題が多いといえ

る。 

(4) 機能評価 

評価：B 

 

機関内 

(1) 主な検証内容 

1) 入退館システム、自動貸出機、自動書庫等との連携 

2) 人事システム、学籍システムからの利用者データ取り込み連携 

3) 連携方法・プロトコル 

4) 連携可能データ 

(2) 検証時に利用した Alma のメニュー項目 

1) Configuration > General> External Systems > Integration Profiles 

2) Analytics > Analytics > Design Analytics 

(3) 検証結果 

1) 入退館システム 

Alma からは、XML/JSON でユーザー情報を API を通じて提供しているため、入

館システムに取り込むことが可能。 

a) https://developers.exlibrisgroup.com/alma/apis 

ただし、国内で多く行われている csv 取り込みで対応するためには、代替と

して、統計データを出力することも可。スケジュール設定をすることで定期的

に csv 形式で利用者情報を入手できる。 

https://developers.exlibrisgroup.com/alma/integrations/resource_sharing/p2p/iso
https://developers.exlibrisgroup.com/alma/integrations/resource_sharing/p2p/iso
https://developers.exlibrisgroup.com/alma/integrations/oai
https://developers.exlibrisgroup.com/alma/apis
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b) Users  

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Analytics/200Users 

2) 自動貸出機 

Alma と貸出端末の接続について、SIP2 プロトコルに対応していれば接続可能。 

a) Self-Check Machines 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Integrations_with_External_Systems/040

Fulfillment/060Self-Check_Machines 

b) 国内で利用されるメーカーのうち、ABC プロトコルを利用する機器もある。 

3) 自動書庫等との連携 

Configuration 画面では、システムを選択する際に、XML、BIBSYS、Dematic 

ASRS、W.B. Meyer がセットされている。 

a) Requests to Remote Storage Facilities  

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Integrations_with_External_Systems/040

Fulfillment/040Requests_to_Remote_Storage_Facilities 

4) 人事システム、学籍システムからの利用者データ取り込み連携 

Alma のユーザー管理は３種類（Staff, Public, or Contact）。使うファイル形式は

xml。FTP サーバーにおいて、import（１回きり）か synchronize（定期的）を行

う 

a) Student Information Systems 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/A

lma_Online_Help_(English)/Integrations_with_External_Systems/050

User_Management/010Student_Information_Systems 

https://developers.exlibrisgroup.com/alma/integrations/user-

management） 

5) 連携可能データ 

学籍番号（チェックデジット含む）+発行回数（それぞれ別の項目）のセットでゲ

ートをコントロールする方法は Alma では使えない。PIN number（チェックデジ

ット含む学籍番号）+発行回数=Primary identifier となるように運用を変更する

ことで対応可能かと思われる。 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Analytics/200Users
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Analytics/200Users
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/060Self-Check_Machines
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/060Self-Check_Machines
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/060Self-Check_Machines
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/040Requests_to_Remote_Storage_Facilities
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/040Requests_to_Remote_Storage_Facilities
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/040Fulfillment/040Requests_to_Remote_Storage_Facilities
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/050User_Management/010Student_Information_Systems
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/050User_Management/010Student_Information_Systems
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Integrations_with_External_Systems/050User_Management/010Student_Information_Systems
https://developers.exlibrisgroup.com/alma/integrations/user-management
https://developers.exlibrisgroup.com/alma/integrations/user-management
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(4) 機能評価 

評価：B 
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(ク) ユーザーサービス（MyLibrary） 
 

概要 

 

利用者認証については、Alma に登録された ID 及びパスワードのほか、LDAP・SAML

（Shibboleth）・OAuth など、主要かつ一般的に用いられる認証システムに対応しており、

学内で用いられる各種のシングルサインオン対応の認証システムとの連係も容易であると

考える。また、SAML（Shibboleth）に対応していることから、学認のサービスプロバイダ

（SP）としても機能できると考えるが、今回は学認の SP としての検証は行っていない。な

お、Alma は IdP の機能は有さない。OAuth に対応していることで Google・ Twitter・ 

Facebook も認証時に利用できる。これにより、例えば学外登録者の利用の際の認証などに

も利用できると考えられる。 

利用者の各種情報は Primo にログイン後、「My Library Card」から参照できる。予約等

については、この画面から確認と取り消し等が可能である。以下に「My Library Card」の

表示例を挙げる。この例では、1 件の延滞、1 件の購入依頼等が表示されている。 

 

 

 

 

 

 

 

 

 

 

 

 ILL/DDS の依頼、予約、購入希望については、検索結果として表示された資料の書誌事

項を元に、あるいは新規に登録して図書館に依頼として送信することができる。また、処理

状況が参照可能である。貸出履歴は、Alma で設定した匿名化が実行されるまでの期間、My 

Library Card から参照可能である。 

 施設予約、ILL/DDS の依頼の新規の依頼については、Primo New UI の設定画面の情報
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が不足しておりマニュアル等による機能の確認に留まった。 

 予算管理については、複写料金などの請求、確認の機能について検証を行った。請求があ

る場合、利用者は My Library Card から確認することができる。WPM Education E-

Payment System と連係し、カードによる支払なども行えるとのことである。国内の会計

系システムとの連係については検証できていないが、利用可能であれば利便性は高いと考

える。また、SAP など一般的なシステムとの連携は可能である。なお、資料購入経費と連動

しての決算などについては検証できていない。 

 

総合評価 

 

B
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34 利用者認証 

(1) 主な検証内容 

1) 認証方法の検証 

(2) 検証時に利用した Alma のメニュー項目 

1) Alma での認証に外部のシステムを利用する場合 

a) Administration > General Configuration > Configuration Menu > 

External Systems > Integration Profiles 

2) Primo での設定 

a) Primo Home > Ongoing Configuration Wizards > User Authentication 

Wizard 

b) Alma で設定した認証方法を Primo に適用する場合は、Primo Back Office で

認証方法を設定する。 

c) Primo 側で SAML, CAS, LDAP, Aleph で認証するか、Alma を経由して認証

するかを設定できる。Social login は Alma 経由の認証のみ利用できる。 

(3) 検証結果 

1) Alma のほか、LDAP・Aleph・SAML（Shibboleth）・OAuth など、主要な認証シ

ステムに対応している。また、Google・Twitter・Facebook の認証が利用できる。 

2) 学認については検証機の制限により、未検証である。 

3) Google・Twitter・Facebook については、利用前に各サービス側で API キーなど

を発行するほか、administrator がユーザー管理画面から Send message で 

social login mail を送信し、承認する必要がある。 

4) Alma に IdP の機能はない。SAML は学内の IdP の利用が前提となっている。 

5) Ex Libris 社への聞き取りによれば、運用されている Alma は SAML を推奨してい

る。利用事例も多く、OAuth がこれに次ぐ。LDAP は減少しているとのこと。 

(4) 機能評価 

評価：A 
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35 MyLibrary 

貸出情報等の参照と変更 

(1) 主な検証内容 

1) 参照できる情報 

2) 変更できる情報 

3) 設定変更の可否 

(2) 検証時に利用した Alma のメニュー項目 

1) Primo ログイン後、「My Library Card」から参照 

2) 利用者向けのメッセージは Administration > User Management > Find and 

Manage Users > （ユーザー管理画面） > Blocks で設定 

3) ユーザー情報の編集可否は  Administration > General Configuration > 

Configuration Menu > General Configuration > Other Settings > 

primo_patron_info_updatable で設定 

(3) 検証結果 

Primo での表示内容と変更、操作の可否は以下の通り。 

1) Overview 

以下の各項の概要が表示される 

a) Loans：貸借中の資料 

延長（Renew）が可能。 

b) Requests：複写等の処理中の資料 

Cancel が可能。 

c) FINE+FEES：罰金・支払など請求が発生した際の項目、金額等 

WPM Education E-Payment System の設定がある場合、この画面からカー

ドでの支払が可能。この機能は未検証。 

d) Blocks+messages：利用制限（Block）そのほかのメッセージ 

fines, outstanding loans, or repeated late book returns で発生する。 

Find and Manage Users > （ユーザー管理画面） > Blocks で設定する。 

この項は利用者からは変更等できない。 

e) Personal Details 

Address, e-mail, Default interface language, 送付されるメール（Activity 

Report, Courtesy letter, Overdue Notice, Loan Status letter, Recall letter, 

Recall Cancellation letter）の受信の可否が変更可能。パスワード（login 
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credentials）が変更可能。編集画面の例を以下に示す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

(4) 機能評価 

評価：B 

(5) 改善への提言 

1) 国内の各種会計システム、あるいは学内の決済システムとの連携が可能であれば、

より有効に利用できると考える。 

 

予約 

(1) 主な検証内容 

1) 資料の予約 

2) 予約内容の変更 

3) 予約した情報の削除 

4) 処理状況の参照 

(2) 検証時に利用した Alma のメニュー項目 

1) Fulfillment 

(3) 検証結果 

1) 資料の予約 

Primo ログイン後、書誌詳細画面の Get It > Request Option > Request から

行う。予約時に、Pickup Location、Not Needed After として日付の設定が、ま
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たコメントの入力が可能である。 

2) 予約内容の変更 

1)で設定した内容は、利用者からは cancel 以外の変更ができない。 

3) 予約した情報の削除 

My library card > requests から cancel が可能である。 

4) 処理状況の参照 

My library card > requests で参照できる。 

(4) 機能評価 

評価：B 

 

ILL/DDS 

(1) 主な検証内容 

1) 依頼の方法 

2) 依頼の変更 

3) 依頼のキャンセル 

4) 処理状況の参照 

(2) 検証時に利用した Alma のメニュー項目 

1) Primo ログイン後「My Library」から参照 

2) Primo にて Primo Home > Ongoing Configuration Wizards > Views Wizard 

で設定 

(3) 検証結果 

1) 検証環境の制約により、マニュアルのうち以下の記載内容により"Resource 

Sharing Request Form"として設定が可能であることを確認した。 

Resource Sharing Request Form 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma

_Online_Help_(English)/Alma-

Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_D

ata_Source/100Direct_Linking_to_the_Resource_Sharing_Request_Form 

(4) 機能評価 

評価：評価なし（検証環境の制約による） 

 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/100Direct_Linking_to_the_Resource_Sharing_Request_Form
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/100Direct_Linking_to_the_Resource_Sharing_Request_Form
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/100Direct_Linking_to_the_Resource_Sharing_Request_Form
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/100Direct_Linking_to_the_Resource_Sharing_Request_Form
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利用者による予算管理 

(1) 主な検証内容 

1) 予算の設定方法 

2) 残額の確認 

(2) 検証時に利用した Alma のメニュー項目 

1) Administration > User Management Configuration 

2) Administration > User Management 

(3) 検証結果 

1) Administration > User Management Configuration > Configuration > Patron 

Charges > Fines/Fees Behavior から、 Fine/Fee type の Credit の Manual 

creation を True に変更する。この操作で、手動での予算設定が可能になる。 

2) Administration > User Management > Find and Manage Users > Fines/Fees 

から当該ユーザーに Credit を Fee として追加。この操作で、利用者が使用でき

る Credit とその金額を設定する。 

 

 

 

 

 

 

 

 

 

 

3) 以後、Fine/Fee はこの Credit から減算される。途中での追加も可能である。 

4) 以下の図は Cancel Fee を Alma から設定したもの。 

a) Credit を 100USD 設定 

b) Cancel Fee として 10USD 徴収 

c) Credit を再度 100USD 設定. “Current fines balance is -190.00. “と表示

されている 

 

 



 別紙  

103 

 

 

 

 

 

 

 

 

 

 

 

d) 利用者が Primo を使用して My Library Card > FINE+FEES から確認でき

る。“Current fines balance is -190.00. “と表示されている。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(4) 機能評価 

評価：B 
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購入希望 

(1) 主な検証内容 

1) 購入希望の手順の確立 

2) 購入希望の変更 

3) 購入希望のキャンセル 

4) 処理状況の参照 

5) 継続購入依頼・中止依頼 

(2) 検証時に利用した Alma のメニュー項目 

1) Primo ログイン後「My Library」から参照 

2) Primo にて Primo Home > Ongoing Configuration Wizards > Views Wizard 

で設定 

(3) 検証結果 

1) "Patron Purchase Request"として検証環境の制約により、マニュアルのうち以

下の記載内容により設定が可能であることを確認した。 

Direct Linking to the Purchase Request Form 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma

_Online_Help_(English)/Alma-

Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_D

ata_Source/104Direct_Linking_to_the_Patron_Purchase_Request_Form 

2) Primo New UI からの購入希望については、検索結果詳細表示(Full View)内に

contextual Purchase Request Form の設定を ProQuest に依頼し動作を確認し

た。Full Views で任意の item の内容を自動転記して購入希望とすることができ

る。 

(4) 機能評価 

評価：評価なし（検証環境の制約による） 

 

施設予約 

(1) 主な検証内容 

1) 施設管理・予約機能 

(2) 検証時に利用した Alma のメニュー項目 

2) Configuration Menu > Fulfillment > Physical Fulfillment > Fulfillment Units 

(3) 検証結果 

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/104Direct_Linking_to_the_Patron_Purchase_Request_Form
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/104Direct_Linking_to_the_Patron_Purchase_Request_Form
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/104Direct_Linking_to_the_Patron_Purchase_Request_Form
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/040Configuring_the_Primo_Front_End_for_an_Alma_Data_Source/104Direct_Linking_to_the_Patron_Purchase_Request_Form
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1) Booking という概念で物理的な本、施設の予約を行う。 

2) 物理媒体の Loan・Request と共通した Fulfillment Unit を作成し、この中で

Booking のためのポリシー（期間など）、対象となる物理的場所、利用権限（学生

は予約不可、など）などを設定する。 

(4) 機能評価 

評価：評価なし（検証環境の制約による） 
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36 新着情報通知 

(1) 主な検証内容 

1) 通知できる情報 

(2) 検証時に利用した Alma のメニュー項目 

1) Primo ログイン後、「My Library Card」から参照 

2) Admin > Manage Users > (各ユーザー) 

(3) 検証結果 

1) 利用者は、Primo のうち「My Library Card」から自らに関連する情報を確認でき、

延滞通知などは電子メールで利用者に送付される。また、利用者は、「My Library 

Card」から、通知の可否を設定できる。 

以下は予約をキャンセルした旨の通知メールの例である。 

 

 

 

 

 

 

 

 

 

 

 

 

再度同じ内容を手動で通知する場合は、Manage User の「Attachments」に送信

した内容（HTML 形式）があり、「Resend Notification」で再送できる。 

手動でその他のメッセージを Primo の「My Library Card」に表示させる場合は、

Manage User の「Blocks」で設定できる。 

(4) 機能評価 

評価：B
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付録：Alma用語集 

 

＜アルファベット順＞ 

 

CKB（Central Knowledge Base） 

中央ナレッジベース。出版社やデータベースベンダーなどから提供された、さまざまな電

子リソースのコレクション（パッケージ）に関するタイトルリスト、各タイトルの提供条

件やアクセス先の URL などの個別情報を集約したポートフォリオから構成される。Alma

においては CZ リポジトリの Inventory 領域において、管理されるコンテンツならびに

ツールとして認識されているが、これらのデータは IZ へと適用させることで、機関の状

況に見合った値に情報を修正、上書き、加筆することができる。 

 

CZ（Alma Community Zone） 

全ての Alma の利用機関において、Alma からアクセスが可能となっている共有リポジト

リ。出版社やデータベースベンダー、あるいはさまざまな機関から提供された書誌データ、

典拠データ、電子リソースの中央ナレッジベース（CKB）が収録されている。 

 

Digital Resource 

自機関が自ら電子化し、自機関のサーバーやネットワーク上で公開しているコンテンツ

のこと。Alma においては、機関外で管理される商用の Electronic Resource とは明確に

異なる存在として扱われる。 

 

EDI（Electronic Data Interchange） 

電子データ交換。Alma と書店や代理店といった取引先と間で交わされる発注や請求とい

ったプロセスを電子的に行うための方法。必要なデータがシステム間で自動交換され、速

やかに双方のシステム上に反映されることから、図書館と書店のいずれにおいても、省力

化が期待される。 

 

Electronic Collection 

複数の電子ブックや電子ジャーナルによって構成されるコレクションのこと。CKB にお

いては、パッケージとして提供されているコレクションを包括的に収録、管理できるよう
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にしている。単に Collection（コレクション）とも言う。 

 

Electronic Portfolio 

電子ジャーナルの各タイトルに対する ISSN や巻号、ライセンス情報を始め、電子ブック

であれば ISBN など、さまざまな電子の個別のアイテムに関する情報を集約することで

作成されたポートフォリオのこと。単に Portfolio（ポートフォリオ）とも称する。 

 

EOD（Embedded Order Data） 

取引先等から提供された、あらかじめ発注に必要な情報が埋め込まれた MARC レコード

を Alma に一括してインポートし、それを利用することで自動発注するという方法。 

 

Fulfillment 

Alma における「紙」の図書や雑誌を借りて返却するプロセスや、電子リソースにアクセ

スするプロセスを総称する用語。 

 

Holdings Record 

所蔵レコード。書誌レコードと、アイテムそのものの情報を記録するアイテムレコード

（Item Record）の中間に位置し、それぞれをリンクさせるレコード。所蔵レコードは単

独で存在することはできず、MMS ID を通じて書誌レコードとリンクしている必要があ

るが、必ずしもアイテムレコードとリンクしている必要はない。一方で、ひとつの所蔵レ

コードに複数のアイテムレコードをリンクすることもできる。所蔵レコードには排架場

所の情報のほか、分類記号などを記録することができる。MARC21 の仕様に準拠してい

る。 

 

Inventory 

自機関や所属するコンソーシアムで所有するか、アクセス権（ライセンス）を与えられた

個々のアイテムを管理するための情報を含む、Alma 上に設けられた領域のこと。「紙」

の図書や雑誌の所蔵情報、電子リソースのナレッジベースなどが含まれる。いわゆる書誌

データや典拠データなど MMS（Metadata Management System）が扱う目録領域はこ

れに該当しない。 

 

Item Record 
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アイテムレコード。アイテムの資料番号や一時的、または恒久的な排架場所、貸出条件な

ど、アイテムそのものに関する情報を記録する。アイテムレコードは単独で存在すること

はできず、所蔵レコード（Holdings Record）とリンクさせる必要がある。 

 

IZ（Institution Zone） 

自機関のみでローカルとして利用するライセンス情報や書誌データ、典拠データ、電子リ

ソースのコレクション、書店や代理店の情報などが収録されている排他的リポジトリの

こと。 

 

ONIX-PL（ONline Information eXchange for Publication Licenses） 

主として出版社や書店向けに提供されている、書誌データや商品情報を異なるシステム

間で交換するための規格である ONIX の派生フォーマットのひとつ。他の ONIX から派

生したフォーマットと同じく、XML で構成されているが、さまざまなライセンス情報を

記述、交換できるという特徴がある。 

 

MD Editor（Metadata Editor） 

Alma のリポジトリにおいて、書誌レコードと所蔵レコードを編集および作成するための

ツール。 

 

MMS（Metadata Management System） 

メタデータ管理システム。CZ や IZ における Repository の書誌データや典拠データとい

った目録情報を管理するためのシステム。 

 

MMS ID 

メタデータ管理システムによって管理される ID。いわゆる書誌レコード ID であり、8-

19 桁の値で設定できる。 

 

Negotiation 

コンソーシアムによる出版社やデータベースベンダーとの交渉を指す。Alma においては

NZ において、コンソーシアムを通じて契約を締結する電子リソースに対し、交渉を踏ま

えて決定される Nagotiation Lisence と呼ばれるライセンスを追加することができる。

Nagotiation Lisence は関連する電子リソースとリンクしており、コンソーシアムの参加
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館は IZ において、このライセンスを用いて、電子リソースを発注、アクセスできるよう

になっている。 

 

NZ（Alma Network Zone） 

コンソーシアム等を形成する複数の Alma の利用館のみが、排他的に Alma からアクセ

スできる共有リポジトリ。コンソーシアム参加館としてのライセンス情報や書誌データ、

電子リソースのコレクション、書店や代理店の情報などを共同で一元的に管理すること

ができる。 

 

OBI（Oracle Business Intelligence） 

Alma のさまざまな統計情報を分析するためのツール。Oracle によって開発されている。

Alma に標準的に付属しており、ユーザーのニーズに応じた、多方面からの分析が可能に

なるよう、充実したカスタマイズ機能を有しているという特徴がある。 

 

PNX Record（Primo Normalized XML Record） 

Primo がディスカバリーサービスとして収集するさまざまなメタデータについて、取り

込みを効率化するために設計された、正規化された XML によるレコードのこと。外部デ

ータベースのメタデータが、Primo に収集され、検索対象として設定されるためには、本

形式のレコードに変換されることが必要となる。 

 

PO（Purchase Order） 

発注そのもの、あるいは発注を表す単位。通常、発注では複数のアイテムを取りまとめて、

書店や代理店に一括して行なうことが多いが、この場合、PO は複数の POL をパッケー

ジ化した単位として扱われる。 

 

POL（Purchase Order Line） 

Alma における発注を管理する基本単位。Alma においては、選書から受入に至るまでの

図書や電子ジャーナルといった各アイテムの流れを管理する際の基準として用いられる。 

 

Primo 

Ex Libris 社が提供しているディスカバリーサービス。Alma においては蔵書検索に特化

した OPAC の提供はなく、「紙」と「電子」を統合的に検索できるディスカバリーサービ
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スとして、Primo または Summon の利用が標準化されている。 

 

Publish 

Alma におけるメタデータについて、外部システムでの利用を目的として、その一部を新

たに抽出、フォーマット変換した上で、該当のシステムに転送するプロセスのこと。例え

ば Alma における特定のメタデータを Primo での検索対象に設定する際などに適用され

る。 

 

Repository 

「紙」の図書や雑誌、電子ブックや電子ジャーナルのコレクションとその提供条件を示す

ポートフォリオなど、Alma が有しているあらゆる情報を指す。CZ の情報など、本来、

自機関としては有していない情報についても、概念的に包括している。Repository は、

書誌データや典拠データを管理する MMS（Metadata Management System）で管理さ

れる目録領域と、それ以外の「紙」の図書や雑誌の所蔵情報など、個々のアイテムを管理

するための情報や電子リソースのナレッジベースで構成される Inventory 領域に大別さ

れる。 

 

STL（Short Term Loan） 

電子リソースに関する短期有償貸出のこと。利用者からアクセス要求のあった電子リソ

ースに関して、購入よりも費用的に抑えられた対価を図書館が支払うことで、数日から 1

ヶ月程度の時限的アクセス権を手に入れる方法。 
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